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IDEAL INDUSTRIES Standard Warranty Policy

IDEAL INDUSTRIES warrants that all Products manufactured or procured by IDEAL
INDUSTRIES conform to IDEAL INDUSTRIES’ published specifications and are free from
defects in materials and workmanship for a period of two (2) years from the date of delivery to the
original Buyer, when used under normal operating conditions and within the service conditions for
which they are designed. This warranty is not transferable and does not apply to used or
demonstration products.

The obligation of IDEAL INDUSTRIES arising from a Warranty claim shall be limited to
repairing, or at its option, replacing without charge, any assembly or component (except batteries
and cable adapters) which in IDEAL INDUSTRIES’ sole opinion proves to be defective within the
scope of the Warranty. In the event IDEAL INDUSTRIES is not able to modify, repair or replace
nonconforming defective parts or components to a condition as warranted within a reasonable time
after receipt thereof, Buyers shall receive credit in the amount of the original invoiced price of the
product.

IDEAL INDUSTRIES must be notified in writing of the defect or nonconformity within the
Warranty period and the affected Product returned to IDEAL INDUSTRIES’ factory, designated
Service Provider, or Authorized Service Center within thirty (30) days after discovery of such
defect or nonconformity. Buyer shall prepay shipping charges and insurance for Products returned
to IDEAL INDUSTRIES or its designated Service Provider for warranty service. IDEAL
INDUSTRIES or its designated Service Provider shall pay costs for return of Products to Buyer.

IDEAL INDUSTRIES shall have no responsibility for any defect or damage caused by improper
storage, improper installation, unauthorized modification, misuse, neglect, inadequate maintenance,
accident or for any Product which has been repaired or altered by anyone other than IDEAL
INDUSTRIES or its authorized representative or not in accordance with instructions furnished by
IDEAL INDUSTRIES.

The Warranty described above is Buyer’s sole and exclusive remedy and no other warranty,
whether written or oral, expressed or implied by statute or course of dealing shall apply. IDEAL
INDUSTRIES specifically disclaims the implied warranties of merchantability and fitness for a
particular purpose. No statement, representation, agreement, or understanding, oral or written,
made by an agent, distributor, or employee of IDEAL INDUSTRIES, which is not contained in the
foregoing Warranty will be binding upon IDEAL INDUSTRIES, unless made in writing and
executed by an authorized representative of IDEAL INDUSTRIES. Under no circumstances shall
IDEAL INDUSTRIES be liable for any direct, indirect, special, incidental, or consequential
damages, expenses, or losses, including loss of profits, based on contract, tort, or any other legal
theory.
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Index of Safety Precautions

IDEAL INDUSTRIES recommends that the user review all of the information in
Appendix A before using the LANTEK tester.

Important Notice

Charge Battery Packs Prior to Use

The battery packs in the Display and Remote Handsets are subject to discharge
even when the units are turned off. With time on the shelf, the battery packs’
charge levels may not support the instrument’s operation. Refer to Chapter 2,
Your Cable Tester for charging instructions and observe all Safety Precautions in
Appendix A.
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Operation Notes, Cautions, and Warnings

The following symbols are used in this manual to indicate that the user should use
particular caution in order to prevent personal injury or damage to the tester or the
system under test.

Exercise caution when you see this symbol. It indicates actions that could
be harmful to the user or to the equipment.

Exercise extreme caution when you see this symbol. It indicates potentially
lethal voltages.
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About This User’s Guide

Chapter 1  Quick Start

This chapter summarizes information and procedures regarding tester function,
unpacking, setup, and operation.

Chapter 2  Your Cable Tester

This chapter describes the LANTEK cable tester, performance specifications,
tester controls, and indicators. It also contains useful information regarding unit
power management.

Chapter 3  Calibration, Configuration, and Special Operations

This chapter describes the test adapters and reference patchcords as well as the use
of the Tone Generator and Digital Talkset. It explains the procedures for
calibration, configuration, cable identification, selecting cable types, and custom
cable settings. The last section depicts the useful effects of performing Time
Domain Reflectometer tests.

Chapter 4  Autotesting

This chapter describes the Autotest function, and provides instructions for setting
up test preferences. This chapter also describes individual tests that run during an
Autotest and provides instructions for viewing and interpreting Autotest results.
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Chapter 5  Analyze Testing

This chapter describes the Analyze test function and provides instructions for
setting up test preferences and running an Analyze test. This chapter also describes
each Analyze test and provides instructions for viewing and interpreting test
results.

Chapter 6  Using LANTEK REPORTER

This chapter contains procedures for LANTEK REPORTER installation,
configuration, operation, uploading test data into a PC database, and for viewing
and printing test reports.

Chapter 7  Cable Testing Fundamentals

This chapter describes test setup, physical and electrical characteristics of cables,
test descriptions, test storage, and data management procedures. This chapter also
describes how to set up different cabling tests, what to do when tests fail, and
typical causes of test failure.

Appendix A  Safety Precautions

This appendix reviews safety information regarding setup and use of the tester.

Appendix B  Customer Support

This appendix contains information regarding Customer Service (Technical
Assistance, Service in the USA, Service Outside the USA) and World Wide Web
Services.
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Appendix C  Measurement Methods and Limits

This appendix contains information regarding cable test accuracy levels, worst
allowable pair-to-pair measured performance levels, and basic and channel link test
limits.

Appendix D  Specifications

This appendix contains information regarding standard and optional cables,
adapters, accessories, and unit specifications.
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Chapter 1
Quick Start

Contents

• What’s in the Box?

• Quick Start Procedures

• Next Steps

What’s in the Box?

The LANTEK you received (Category 6 or Category 7 tester) comes in either the
Basic package or Premier package based on your request. See Figure 1-1.

The Basic package consists of:

• Display Handset • Serial Interface Cable

• Remote Handset • USB Cable

• NiMH Batteries (2) • Cat 6 Channel Adapters (2)

• AC Wall Adapters (2) • Cat 7 Channel Adapters (2), LANTEK 7 only

• LANTEK Reporter • Cat 6 RJ45 Patchcords (2)

• Quick Reference Guide • Cat 7 RJ45 to Tera Patchcords (2), LANTEK 7 only

• Soft Carrying Case • Cat 7 Tera Patchcords (2), LANTEK 7 only

• Hanging Strap (2)

The Premier package consists of:

All items supplied in the Basic package with a substitution of a hard case for the
soft case. In addition you get the (1) PCMCIA adapter, (1) Compact Flash Card
(32 MB), (1) Flash card reader, and (1) 2-port battery charger.
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Figure 1-1: Contents of Package
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Quick Start Procedures

The objective of this section is to supply a highly experienced cable installer with
enough information to perform an Autotest on a twisted pair cable. For more
detailed information refer to Next Steps, page 1-7.

Power-up

Power-up the Display Handset by pressing the On/Off  key.

Note: The Remote Handset will be powered up automatically by the Display Handset
when the test begins.

Self-Test

When the LANTEK Tester is turned on, it displays a Self-Test In Progress
message and performs a quick self-test.  An alert message is displayed if the
self-test determines that calibration or repair is necessary.

Figure 1-2: Self Test In Progress
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Tester Calibration

A calibration screen will always appear 7 days after the last field calibration.
The purpose of calibration is to (1) synchronize the units, (2) qualify (test) the
patchcords and (3) gather loss data regarding the patchcords and mated
connections.

Note: Calibration should also be done whenever there is a change of the reference
patchcords.

To calibrate the tester:

1. Connect the channel adapters to the Display Handset and Remote Handset.

2. Power the units on.

3. Connect one of the two appropriate patchcords to the adapters of the DH and
RH units.

4. From the DH Ready screen, select Field Calibration .

5. From the Field Calibration screen, select Start on the DH.

6. At completion of the first patchcord process, disconnect the first patchcord
from the adapters of the DH and RH and insert the second patchcord into both
of the units’ adapters.

7. Select Start on the DH.

8. At completion of the second patchcord process, disconnect the second
patchcord from one of the units and re-insert the first patchcord to the unit’s
adapter not connected to a patchcord.

The field calibration is complete and you are ready to perform tests.

If the calibration was unsuccessful, proceed to Chapter 3, Tester Field
Calibration. If you are unable to fix the problem, contact your local distributor or
an IDEAL INDUSTRIES service facility for assistance.
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Twisted Pair Cable Connections

Most Autotests are performed with the DH and RH connected at opposite ends of
the cable under test. The minimum level of connectivity required depends on the
test and cable type selected.

• Some tests can be performed without the RH. Stored test results or test
printouts will indicate the presence or absence of the RH during the test.

• If the test requires the RH, the DH will first attempt to communicate with the
RH. If unable to communicate, the DH will display a message that it is
looking for the RH.

Observe the following cautions while connecting the tester:

Shielded Cabling Systems

Do not create testing ground loops with shielded cable systems.
Shielded cable systems (i.e., 4 pair STP, or Coaxial) present a unique
testing problem due to the cable shield’s ground connection. The
LANTEK unit can test these systems to specifications only if the
handsets are operated on battery power and not connected to a PC or
printer using a copper serial cable.

If connection to a printer or PC is essential to perform testing, IDEAL
INDUSTRIES recommends using battery-operated devices and
removing any wall power charging inputs. If this is not possible, an
optically isolated serial cable should be used during testing to isolate
the tester from all other ground connections.

TELCO Lines

Do not connect the tester to a live or active TELCO lines. If you
accidentally plug the unit into outlets with active TELCO lines present
(indicated by a “Voltage Exceeds Limits” warning message) disconnect
the tester immediately.
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Permanent Link Test Setup

1. Attach the channel adapters to both the Display and Remote Handsets.

2. Attach the appropriate patchcords to the adapters.

3. On the horizontal cable to be tested, disconnect the corresponding user
patchcords from the network patch panel and the RJ-45 or Tera wall outlet.

4. Connect the DH with the adapter and the appropriate patchcord end to the
network patch panel, and then connect the RH with the adapter and the
appropriate patchcord end to the wall outlet.

Note: Prior to testing, check that the Cable Type is set for Permanent Link.

Channel Link Test Setup

1. Attach the channel adapters to both the Display and Remote Handsets.

2. On the link to be tested, disconnect the corresponding user patch cords from
the network equipment.

3. Connect the DH adapter to the patch panel using the user patchcord and the
RH adapter to the wall outlet using the user patchcord.

Note: Prior to testing, check that the Cable Type is set for Channel Link.

Set Autotest Preferences

Autotest is the most frequently used test mode. A number of preferences can be
selected for the Autotest function:

• Simple Cable ID • Pass Fail Icon • Stop on Fail

• Autosave • Save Graphs • Auto Increment

• Marginal pass/fail • ACR • Resistance

• Capacitance • Impedance • Enable 24 ELFEXT
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To set Preferences:

1. From the DH Tools screen, select Preferences .

2. Select Autotest Preferences.

3. From the open Autotest Preferences screen, set the preferences as required
(refer to Chapter 3, Set Autotest Preferences).

Perform Autotest on a Twisted Pair Cable

The selection of cable type determines the default tests and limits included in an
Autotest suite.

1. Press Shift  and Setup  simultaneously or select  on the DH
Ready screen to choose the Cable Type (refer to Chapter 3, Selecting Cable
Type).

2. Press Autotest  to begin testing. The cable tester will perform a
predefined test suite.

3. The test result is displayed below the Title Bar at the top right corner.

A checkmark indicates an overall pass. A  indicates an overall fail.

4. To interpret, save, or print an Autotest result, refer to Chapter 4, Autotesting.

Next Steps

Refer to the following chapters for more information regarding the setup and
operation of your LANTEK tester:

Chapter 2  Your Cable Tester

This chapter describes the LANTEK tester controls, indicators, and screens. It
also contains information regarding tester power management.
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Chapter 3  Calibration, Configuration, and Special Operations

This chapter describes the test adapters and reference patchcords as well as the
use of the Tone Generator and Digital Talkset. It explains the procedures for
calibration, configuration, cable identification, selecting cable types and custom
cable settings. The last section depicts the useful effects of performing Time
Domain Reflectometer tests.

Chapter 4  Autotesting

This chapter describes the Autotest function and provides instructions for setting
up test preferences. This chapter also describes individual tests that run during an
Autotest and provides instructions for viewing and interpreting Autotest results.

Chapter 5  Analyze Testing

This chapter describes the Analyze test function and provides instructions for
setting up test preferences and running an Analyze test. This chapter also provides
instructions for viewing and interpreting test results.

Chapter 6  Using LANTEK REPORTER

This chapter describes how to upload test data from the LANTEK tester to a PC
or laptop and how to organize and print the test data.

Chapter 7  Cable Testing Fundamentals

This chapter describes physical and electrical characteristics of cables, test
descriptions, test storage and data management procedures. This chapter also
describes how to set up different cabling tests, what to do when tests fail and
typical causes of test failure.
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Chapter 2
Your Cable Tester

Contents

• The LANTEK Cable Tester

• The Display Handset

• The Remote Handset

• Operational Sequence

• Battery and Power Management

The LANTEK Cable Tester

The LANTEK is a high-performance portable LAN cable tester designed to test
and measure twisted pair and coaxial cable used for high-speed data
communications networks.

The LANTEK 7 tester is capable of certifying Category 5, 5e, 6, and 7 cables to
Level III accuracy with a frequency of 750 MHz (350 MHz for the LANTEK 6),
and will perform a frequency sweep based platform with vector (amplitude and
phase) capabilities. This instrument is designed to meet the current test
requirements of the TIA/EIA 568 and ISO 11801 standards including “Permanent
Link” characterization.
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Features of the Tester

¼ VGA (320 x 240) color LCD DH display with backlight.

Advanced TDR capabilities, including Fiber Optic capability (with TRACETEK
adapter module).

PCMCIA double height slot for user removable and replaceable CF (Compact
Flash) memory modules.

Digital talkset including FIBERTEK compatible capability (with FO adapter
module).

USB and serial ports for downloading and communication with standard PC.

Both DH and RH have a “Kick stand” for optimum display visibility on the
bench.

The RH has a two line alphanumeric B/W LCD display and a reduced keypad set.

Initiate Autotest from either the DH or RH.

IDEAL’s revolutionary Adapter modules with locking mechanisms (Patent
Pending).
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Performance Specifications (Copper)

Delay

Range

Resolution

Accuracy

0-8000nsec

1nsec

+(3% + 1ns)

Length

Range

Resolution

Accuracy

Propagation

2000 ft.

1ft.

3% + 3ft.

0.5 – 0.99c

Cable Capacitance

Range

Resolution

Accuracy

0 – 100nF

3dig

+(2% +20pF)

DC Loop Resistance

Range

Resolution

Accuracy

0 – 200ς

0.1ς

+(1% +2ς)

Attenuation

Frequency Range

Measurement Range

Dynamic Range

Frequency Step Size (kHz)

Resolution

Accuracy

1 - 350 MHz (LANTEK 6)
1 - 750 MHz (LANTEK 7)

0 – <90dB

55dB to 700 MHz

150,250,500,1000

0.1dB

Exceeds Level III Accuracy
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NEXT

Frequency Range

Measurement Range

Dynamic Range

Frequency Step Size (kHz)

Residual NEXT

Resolution

Accuracy

1 - 350 MHz (LANTEK 6)
1 - 750 MHz (LANTEK 7)

20 – 100dB

70dB to 700 MHz

150,250,500,1000

72dB

0.1dB

Exceeds Level III

Return Loss

Frequency Range

Measurement Range

Frequency Step Size (kHz)

Resolution

Accuracy

1 - 350 MHz (LANTEK 6)
1 - 750 MHz (LANTEK 7)

0 – 30dB

150,250,500,1000

0.1dB

Exceeds Level III

Auto Test Time

Cat 5-E
Cat 6

Certification to 750 MHz
(LANTEK 7 only)

<25 seconds
<30 seconds

<35 seconds

Average Noise

Range

Bandwidth

Resolution

Accuracy

0 – 2Vrms

40 – 500 Hz

10mVrms

+(3% +20mVrms)
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Impulse Noise

Count Range

Threshold Range

Threshold Resolution

Threshold Accuracy

Min pulse width

0 – 9999 counts/sec

0 – 2V

10mV

+(5% +20mV)

10ns above threshold

ELFEXT

Frequency Range

Measurement Range

Dynamic Range (FEXT)

Frequency Step Size (kHz)

Residual FEXT

Resolution

Accuracy

1 - 350 MHz (LANTEK 6)
1 - 750 MHz (LANTEK 7)

20 – 100dB

70dB to 700 MHz

150,250,500,1000

72dB

0.1dB

Exceeds Level III Accuracy
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The Display Handset

The LANTEK Display Handset performs as the command unit. This allows you
to control procedural preference and test functions used during the performance of
various cable test activities.

Display, Controls, Indicators, and Interface

Figure 2-1 shows the controls and indicators of the Display Handset (DH). Table
2-1 provides a brief description of each DH feature.

Figure 2-1: Display Handset (DH)
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Table 2-1: Display Handset (DH) Keys, LCD, and Connectors

 Item DH Front Panel Description
1 Graphical Display Presents menus, test results, graphs, action choices,

and option keys.
2 Option Keys Select menu options displayed on screen.
3 Arrow/Enter Keys Allow up, down, left, and right movement on the

display.
Enter key selects a highlighted option or saves
changes.

4 AUTOTEST Key Perform a fast suite of tests. Test results are
presented as pass/fail. Suites for established
standards are preprogrammed in the tester.

5 Wiremap Key Find shorts, opens, and miswires such as split and
reversed pairs.

6 Length/TDR Key Initiate a Length or TDR test.
7 Talk/Analyze Key Activate/deactivate the Talkset function or Select

option to perform individual cable tests (real time).
8 Help/Setup Key Display Help info or open cable type setup screen
9 Escape Key Abort and exit the current screen without making

changes.
10 Alphanumeric Keys Enter numbers, letters or special characters.  Select

numbered menu options.
11 Shift Key Toggle key activities having dual functions.
12 Backlight Key Toggle the screen backlight on/off.
13 On/Off Switch Power the Display Handset on/off.
14 Low-Crosstalk

Connector Port
Connect an adapter.

15 Talkset Jack Connect a Talkset headset and microphone.
16 DC Input Jack Connect an external power supply.
17 PCMCIA Slots Insert memory cards for data storage.
18 USB Port PC upload port.

Also used to load software upgrades.
19 DB-9 Serial Port Printer and PC upload port.

Also used to load software upgrades.
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VGA Front Panel

The Ready screen appears when the unit is powered up.

Note: A warning screen will appear reminding you to perform a field calibration if one has
not been performed within the last 7 days. You can still perform testing but the
test results may not be qualified or reliable.

Figure 2-2: LCD Ready Screen
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Table 2-2: Ready Screen Indicators

Item Function Description
1 Battery Meter

or
AC Cable

Display remaining battery power level (from
Empty to Full) or
Indicate when the unit is running off AC power.

2 Talk Set Indicator Indicate when the Talk Set function is available.

3 Storage Device Indicator
and Memory Usage

Display whether Compact Flash Memory or
alternate device is used to store data. Also
indicates the total number of records stored.

4 Screen Title Display the screen title.

5 Time and Date Display time and date information.

6 Setting Display the cable type selected for testing.

7 Job Title Display the current job name.

8 Function Title Display the title of the highlighted function.

9 Cable ID Icon Select the cable naming function.

10 Stored Test Icon Select the stored test file manager function.

11 Field Calibration Icon Select the field calibration function.

12 Preferences Icon Select the instrument preferences function.

13 Instrument Information
Icon

Select the instrument information function.

14 Analyze Icon Select the option to perform individual cable
tests (real time).

15 Fiber Optics Icon Select the fiber optics function.

16 Cable Type Icon Select or edit a cable type.



Chapter 2
Your Cable Tester

2-10

Hard and Soft Keys

User options will often appear at the bottom of the tester display screen over the
four function keys positioned directly below the display. To select an action, press
its corresponding function key.

In the example below, press the Function keys directly below the screen to adjust
the Timeout options. The soft key will indicate the function of the key below: F1
to increase or F2 to decrease.

Soft Keys

Function Keys
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Table 2-3: Soft Key Descriptions

Soft Key Description
Delete alphanumeric character(s) at the cursor

Delete alphanumeric character(s) left of the cursor

Insert alphanumeric character(s) at the cursor

Insert an incremental value from the source or near-end

Insert an incremental value to the far-end

Show a list of options to select from

Begin or Run the selected activity

Accept the new changes upon exiting the activity

Exit the activity without making changes

Display graphs

Save data to the current file or use the auto naming
convention

Save data to a renamed file or overwrite an existing file

Print data

Show a list of manufactured cables

Create a Custom Cable

Display Nominal Velocity of Propagation

Page-up or increase value

Page-down or decrease value

Increase value 1 unit

Increase value 10 units
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Table 2-4: Soft Key Descriptions (Continued)

Soft Key Description
Decrease value 1 unit

Decrease value 10 units

Activate/Deactivate an item in a list box
A box containing an X mark indicates the activity is on.
An Open box indicates off.

12 hour time format

24 hour time format

Measurement in feet

Measurement in meters

Manual setting

Automatic setting

Select an Item

Automatically calculate a new NVP value
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Display Handset Interface Ports

Figure 2-3: Display Handset Interface Ports

Table 2-4: DH Connectors

Item Connector Description

1 Talkset Jack Connect the Talkset to the tester.

2 DC Input Jack Charge the battery in the handset.

3 DB-9 Serial Port Supports the following functions:

• Print test results on a serial printer.

• Upload stored test results to a PC.

• Load firmware upgrades.

4 USB Port Supports the following functions:

• Upload stored test results to a PC.

• Load firmware upgrades.

5 Low-Crosstalk
Connector

Attach adapters for all types of cables.
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Removable Mass Storage

The LANTEK tester provides two PCMCIA slots (Slot 0/Slot 1) for compact flash
memory. These external memory modules can be used for storing test results.
Storage will be organized in a standard Windows file structure with folders
having names corresponding to job names and containing the test’s data files.

Figure 2-4: PCMCIA Slots

The storage system can accommodate compact flash memory up to 256 MB. The
firmware will automatically present the option of moving test data from the
internal memory to the Compact Flash, if the flash card is installed. The stored
test data from the flash card can be transferred to a PC or laptop through the use
of a flash card reader.

Figure 2-5: PCMCIA Adapter, Compact Flash Card and Reader
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The Remote Handset

The RH (Remote Handset) works with the DH (Display Handset) to perform
Autotest or individual real time Analyze tests. The RH terminates the cable link
and communicates with the DH. The RH is automatically activated by the DH.
The RH needs to have power available when performing a field calibration,
otherwise, the DH will not find it.

Display, Controls, Indicators, and Interface

Figure 2-6 shows the controls and indicators of the Remote Handset (RH).
Table 2-7 provides a brief description of each RH feature.

Figure 2-6: Remote Handset (RH)
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Table 2-5: Remote Handset (RH) Keys, LED, and Connectors

Item RH Front Panel Description
1 B/W LCD Two line alphanumeric display

2 Hazard LED Excessive line voltage present (TELCO)

3 Pass LED Successful test results

4 Fail LED Unsuccessful test result(s)

5 On LED RH unit on

6 Autotest Key Press to activate Autotest

7 Escape Key Abort and exit the current activity without making
change.

8 Tone Key Press to activate/deactivate Tone

9 Talk Key Press to activate/deactivate Talkset

10 Shift Key Toggle key activities having dual functions

11 Backlight Key Toggle the screen backlight on/off

12 On/Off Switch Power the Remote Handset on/off

13 Low-Crosstalk Connector
Port

Test access cable connector

14 Talkset Jack Connect a Talkset headset and microphone

15 DC Input Jack Connect an external power supply

16 DB-9 Serial Port Interface to a PC or serial printer

17 USB Port Interface to a PC
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Remote Handset Interface Ports

Figure 2-7: Remote Handset Interface Ports

Table 2-6: RH Connectors

Item Connector Description
1 Talkset Jack Connect the Talkset to the tester

2 DC Input Jack Charge the battery in the handset

3 DB-9 Serial Port Load firmware upgrades

4 USB Port Load firmware upgrades

5 Low-Crosstalk
Connector

Attach adapters for all types of cables.
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Operational Sequence

• The DH searches for the RH.

• During testing, if the two handsets are unable to communicate, the DH will
display a message that it is searching for the RH and continue trying to
establish communications until you manually cancel the operation or the RH
is found.  If the handsets are unable to establish communication, check the
links to verify proper connection.

• During field calibration, if the two handsets are unable to communicate, the
DH will display a message instructing you to connect the DH and RH together
using the adapters and reference patchcords. If you attempt to run the test
without the adapter, the DH will display a warning message.

Battery and Power Management

Both the Display and Remote Handsets use interchangeable rechargeable NiMH
(Nickel Metal-Hydride) battery packs.

• The DH (Display Handset) can be run on battery power for approximately
eight hours. Actual battery power times will vary based on factors such as
operating time versus standby time, use of the display backlight, and
temperature.

• When the battery is almost empty, the tester displays a warning message. The
tester will automatically shut down before testing results are affected.

• The RH (Remote Handset) can be run on battery power for approximately
eight hours.

• After a brief period of inactivity, the DH and RH automatically power down
to save battery power.
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Operating the DH and RH from an AC Power Source

The DH and RH handsets can be operated from an external DC source
(AC/DC Wall Cube).

Figure 2-8: Tester AC/DC Wall Cube Adapter

When the AC/DC Wall Cube Adapter is used to power the handsets:

• Both handset batteries will receive a trickle charge.

• The DH handset will display the AC plug and cable indicator at the top left of
the screen.

Only the Wall Cube provided with the instrument should be used. Other
types of Wall Cubes may cause damage to the tester. These adapters are
currently available for European, United Kingdom and North American
AC power.

Note: When the batteries become fully charged and the wall cube is still connected, the
batteries will warm slightly. This does not affect the operation of either the DH or
the RH.
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Battery Charging

The handset batteries are recharged using the AC/DC Wall Cube. The DH uses
battery powered flash ROM to store handset data and settings whenever the
battery is removed from the tester. The internal flash ROM battery has a three
year life expectancy.

The batteries can be recharged in the handsets (using the AC/DC Wall Cube) in
about 8 hours.

Note: Charge time will vary, depending upon battery level at the time of charging.
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Adapters and Reference Patchcords

The Test Adapters for the LANTEK 6/7 Cable Tester look similar to the Channel
Adapters and can perform calibration of the test units as well as Permanent Link
and Channel Link testing.

The LANTEK 6 Cable Tester is supplied with two Category 6 Test Adapters and
two Reference Patchcords with Category 6 plugs at both ends.

The LANTEK 7 Cable Tester is supplied with two Category 7 Tera Test Adapters
and two sets of Reference Patchcords.

• The first set of Reference Patchcords have Tera plugs at both ends.

• The second set of Reference Patchcords have Tera Plugs at one-end and
Category 6 RJ45 plugs at the other end.

Table 3-1: LANTEK 6 Test Adapter and Reference Patchcord Usage

Type of Test
Cat 6

Channel Adapter

Cat 6 to Cat 6
Reference

Patchcords
Cat 6 to Cat 6

User Patchcords
Calibration ü ü ü *

Cat6/5e Class E/D
Channel

ü ü 

Cat6/5e Class E/D
Permanent Link

ü ü ü *

* Note: Good quality user patchcords may be used for permanent link testing if the units
have been calibrated with them.
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Table 3-2: LANTEK 7 Test Adapter and Reference Patchcord Usage

Type of Test

Tera Cat 7
Channel
Adapter

Tera to Tera
Reference
Patchcords

Tera to Cat 6
RJ45

Reference
Patchcords

Tera to Tera
User

Patchcords
Calibration ü ü 

Cat 7-Class F
(Tera) Permanent
Link

ü ü ü 1

Cat 7 Class F
(Tera) Channel

ü ü 

Cat 6/5e Class E/D
Permanent Link

ü ü 

Cat 6/5e Class E/D
Channel

2

Note: 1  Good Quality User patchcords may be used for permanent link testing if the
units have been calibrated with them.
2 Category 6 Test Adapters are required for Channel Testing. They also provide an
additional option for Category 6 Permanent Link testing on the LANTEK 7.

Benefits of Using the New Adapter Design

Reduction of the Cost of Ownership

The same adapter can be used for permanent and channel link testing, thereby
reducing the number of adapters required to perform the same function.
Performing tests on vendor’s proprietary plugs may require a new set a patchcords
not an additional set of adapters.
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Reduction in Product Complexity

Fewer adapters to manage, less adapters to order, less misplacement at the
worksite or office.

Reduction in Adapter Connector Wear

The 160-pin connector is secured to the tester, thereby locking with the tester
creating no flexing of the pin connection during day to day operation. The adapter
is a multi-use device facilitating fewer switching activity, reducing wear.

Reduction of Maintenance Costs

Repeated testing requires multiple plug insertions when moving from link to link.
Repeated insertions cause the plug to wear, necessitating its replacement. The new
design allows only the reference patchcord to be replaced, which is considerably
less expensive than replacement of the adapter.

Reduction of Installer Test Time Caused by Adapter Switching

Previously, performing different tests or a calibration required switching the
adapter. The new design requires the use of one adapter for all functions, resulting
in time savings when performing tests or calibration.
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Design Overview

The test lead to the adapter is a mated pair connection rather than a soldered
connection. Allowing the use of the same adapter for both Permanent Link and
Channel Link testing. The overall loss measurement is shown in Figure 3-1.

Permanent Link

Horizontal Cable

Channel

Adapter

Tester

Remote EndDisplay End

Adapter

Tester

TAI TAI

TAI - Tester Adapter Interface

Mated Plug Jack Pair

Figure 3-1: Loss Components of a Total Link

All of the loss effects of each of the above components must be known in order to
properly report the Loss Effects of a Permanent Link or a Channel Link.

• Channel losses can be measured when the background loss effects of the test
units, adapters, and the test unit/adapter interfaces are subtracted from the
measured overall raw loss effects.

• Permanent link losses are measured when the loss effects of the test lead
patchcords and the mated pair making up the adapter/patchcord interface are
subtracted from the overall Channel losses.
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Calibration

Calibration is performed with the Channel adapters and patchcords. The Reference
Patchcords supplied have plugs that match the jacks in the Channel adapters. We
recommend that you calibrate with the patchcords that will be used for Permanent
Link Testing. These cords should be identical, good quality, shielded patchcords.

Once the calibration is complete, the information is retained by the test unit to
disclose the characteristics of the mated pair used to connect the patchcord cable
to the test adapter.

Performing a Permanent Link Test

1. Insert one end of a patchcord into the adapter’s jack at both the Near-End
and the Far-End.

2. Insert the other end into the Permanent Link’s jack at both the Near-End and
the Far-End.

3. Select the appropriate Permanent Link Test.

4. Start the Autotest Function.



Chapter 3
Calibration, Configuration, and Special Operations

3-7

Performing a Channel Link Test

1. Insert one end of a patchcord into the adapter’s jack at both the Near-End
and the Far-End.

2. Insert the other end into the Channel Link’s jack at both the Near-End and
the Far-End.

3. Select the appropriate Channel Link Test.

4. Start the Autotest Function.

Warning Screens

In response to a change in parameter(s), failure, harmful condition, or operational
limitation, the tester will display a warning screen. This screen advises you of the
activity or request you are or will be engaged in. The screen will prompt you to
respond in a YES/NO manner.

Figure 3-2: Sample Warning Screen
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Tester Field Calibration

It is recommended that the LANTEK tester be calibrated every 7 days. A
calibration reminder message will appear on the Display Handset screen when
calibration is requested.

The purpose of calibration is to (1) synchronize the units, (2) qualify (test) the
patchcords and (3) gather loss data regarding the patchcords and mated
connections.

To calibrate the tester, perform the following steps:

1. Connect the channel adapters to the Display Handset and Remote Handset.

2. Power both units on.

3. Connect one of the two appropriate patchcords to the adapters of the DH and
RH units.

Figure 3-3: Tester Field Calibration Setup
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4. From the DH Ready screen,

select Field Calibration .
The Calibration screen appears.

5. From the Field Calibration

screen, select  to begin
the calibration process on the
first patchcord.
Calibration takes approximately
one minute to complete.

6. At completion of the first
patchcord process, disconnect
the first patchcord from the
adapters of the DH and RH and
insert the second matching
patchcord into both of the units
adapters.

7. From the Field Calibration screen, select  to begin the calibration
process on the second patchcord.

8. At completion of the second patchcord process, press  to return to the
Ready screen.

9. Disconnect the second patchcord from one of the units and re-insert the first
patchcord into the unit’s adapter not connected to a patchcord. The field
calibration is complete and you are ready to perform tests.
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If calibration is unsuccessful, the tester will briefly display either a Warning screen
displaying “No Remote Handset”or a Calibration Failure screen.

The display handset will return to the Ready screen upon exiting from a calibration
error screen.

Note: If the field calibration is out of date, you can still perform an autotest but the results
may not be qualified or reliable.

Table 3-3: Unsuccessful Field Calibration Checklist

Action Result
Check the battery power on
both the Display and Remote
Handsets.

Check the DH for a low battery message.
If the Display Handset indicates a low battery, you must
recharge the battery before the unit will pass calibration.

The RH will not respond if its battery is low.

Check the adapter and
connections.

Make sure the adapter is correctly seated and there are
no bent pins.

If you are unable to successfully calibrate the tester, contact your local distributor
or an IDEAL INDUSTRIES service facility for assistance.
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Tester Configuration

Most tester configuration parameters are set from the Preferences screen.

To open the Preferences screen:

1. From the Ready screen, select

the Preferences .

The Preferences screen
appears.

2. Use the Up/Down Arrow keys to select one of the following options:

• Enter User Information • Set Date and Time

• Set Autotest Preferences • Select Display Language

• Adjust Display Contrast • Restore Factory Defaults

• Set Time-Out Options • Pack Memory

• Set Measurement Units • Clear Memory

• Configure the PC & Printer I/F • Select Save Media

• Configure the Talkset Option
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Entering User Information

User information identifies the unit operator for test reports.

1. From the Preferences screen,
select User Information.

The User Information screen
appears.

2. Use the Alphanumeric keys to enter your name. Press the Left or Right
Arrow keys to move the cursor from one character to the next.

3. Use the Up or Down Arrow keys to move between the fields.

4. Press  to save or   to exit without saving changes.
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Setting Autotest Preferences

Autotest can be set to automatically stop on the first failed test, as well as to print,
save, and name test results at the completion of each test series.

Table 3-4: Autotest Preference Options

Option Action

Simple Cable ID Assigns a fixed alpha value for the Cable ID.

Pass/Fail Icon Display Pass or Fail icon for overall test and individual test.

Stop on Fail Autotest aborts at the first failed test. Otherwise, Autotest continues
until all tests are completed, regardless of results.

Note: If a wire map cannot be reliably completed due to gross
miswiring, the Autotest may abort regardless of the setting of
this preference.

AutoSave Autotest automatically names and saves any passed Autotest results.
Failed tests are not automatically saved.

Save Graphs Displaying graphs on the DH requires data to be transferred from
the RH to the DH. To save time during testing, do not select this
option.

Auto Increment Autotest automatically increments the Single and Double Cable ID
test counters.

Marginal
Pass/Fail

Display Pass or Fail with an * identifying marginally effected test(s).

ACR Perform ACR Test.

Resistance Perform Resistance Test.

Impedance Perform Impedance Test.

Enable 24
ELFEXT

Enable measurements at the DH for all possible pair combinations.
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1. From the Preferences screen,
select Autotest Preferences.
Press Enter. The Autotest
Preference screen appears.

2. Press the Up/Down Arrow
keys to highlight the desired
option.

3. Choose Select to activate or
deactivate the highlighted
option.

4. Press  to save or  to exit without saving changes.
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Adjusting the Display Contrast

1. From the Preferences screen,
select Contrast. Press Enter.
The Contrast screen appears.

2. Select  /  or

 /  to adjust the
screen contrast.

3. Press   to save or   to exit without saving changes.



Chapter 3
Calibration, Configuration, and Special Operations

3-16

Setting Timeout Options

Set time-out options to help conserve battery power when the tester is not in use.

Default Timeout Settings:

Backlight 1 minute

Power 30 minutes

1. From the Preferences screen,
select Timeout Options.
Press Enter. The Timeout
Options screen appears with
the cursor on the Backlight
Timeout option.

Note: The timers begin counting from
the last key press.

2. Select  or  to
adjust the Backlight Timeout
setting.

3. Press the Down Arrow key to select the Power Off Timeout option.

4. Select  or  to adjust the Power Off Timeout parameter.

5. Press  to save or  to exit without saving changes.
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Setting Length Measurement Units

Use this option to set the unit of measurement parameter for length measurements.
The default setting is “feet.”

1. From the Preferences screen,
select Measurement Units.
Press Enter. The Measurement
Units screen appears.

2. Select either  or

 to set the unit of
measure to feet or meters.

3. Press  to save or  to exit without saving changes.
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Configuring the PC or Printer Interface

Use this option to configure the serial port and select the type of printer being
used.

1. From the Preferences screen,
select PC & Printer I/F.
Press Enter. The PC & Printer
I/F screen appears.

2. Press the Arrow keys to
highlight the desired parameter.

3. Select  or  to
input the desired setting.

4. Press  to save or  to exit without saving changes.
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Configuring the Talkset

LANTEK testers are “talkset ready.” Use this option to configure communications
between the DH and the RH through an externally attached microphone/headset.

If the Talkset is enabled, the DH and RH may be switched between “Test” and
“Talk.” If the Talk button on either unit is momentarily depressed, both units will
return to “Test” mode.

If the Talk button on either unit is momentarily depressed when the units are in
“Test” mode (and not currently testing), the units will switch to “Talk” mode. The
units will remain in “Talk” mode until the Talk button on either unit is depressed,
the AutoTest button is depressed, or after a period of time of no talk activity is
detected by the DH.

During fiber testing, the lasers in each adapter are not powered when the DH and
RH are in “Talk” mode. Prolonged active talk will not allow the Timeout to return
the units to “Test” mode. This may permit the lasers’ temperature to drop below
their threshold operating temperatures, requiring a new warm-up sequence for the
fiber adapters. (See IDEAL’s FIBERTEK User’s Manual.)

1. From the Preferences screen,
select Talkset.
Press Enter. The Talkset
screen appears.
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2. Press the Arrow keys to
highlight the desired setting.

3. The default setting for Talkset
is “Manual”.

Select  or  to
select the desired setting.

4. To talk with someone using the talkset both the Display Handset and the
Remote Handset must be connected to a cable.

5. If the talkset is in Manual setting, select   or  
to adjust the audible volume.

6. Press  to save or  to exit without saving changes.
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Setting Date and Time

Accurate date and time settings are necessary to create reliable record and report
information.

1. From the Preferences screen,
select Date and Time.
Press Enter. The Date and
Time screen appears.

2. Select  or  to
select the desired time format
setting.

3. Use the Arrow keys to highlight the parameter to be changed.

4. Press or select the Alphanumeric or soft keys to enter the desired setting.

5. Repeat steps 2 and 3 until all of the desired parameters have been set.

6. Press  to save or  to exit without saving changes.
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Selecting a Display Language

You can select one of six languages for the tester display screen:

• English (Default) • Italian

• French • Portuguese

• German • Spanish

1. From the Preferences screen,
select Language.

Press Enter. The Language
screen appears.

2. Select  or  to
select the desired language.

3. Press  to save or   to exit without saving changes.
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Restoring Factory Defaults

Use this option to reset all unit settings to their factory defaults.

1. From the Preferences screen,
press the Arrow keys to
highlight Restore Defaults.

2. Press Enter to restore the unit
to the factory default settings.

3. A Warning screen will appear.

Select  to accept the
changes or

Select  to exit this
screen without making
changes.
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Pack Memory

Use this option to clear the tester memory of test(s) marked for deletion.

1. From the Preferences screen,
press the Arrow key to
highlight Pack Memory.

2. Press Enter to clear the tester
memory of scheduled deletions.

3. A Warning screen will appear.

Select  to accept the
changes or

Select  to exit this
screen without making
changes.
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Clear Memory

Use this option to clear the tester memory of all data.

1. From the Preferences screen,
press the Arrow key to
highlight Clear Memory.

2. Press Enter to clear the tester
memory.

3. A Warning screen will appear.

Select  to accept the
changes or

Select  to exit this
screen without making
changes.

Note: There is no undelete option
when Clear Memory is used. All
stored tests will be permanently
deleted.
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Select Save Media

Use this option to select the type of tester storage memory to use.

1. From the Preferences screen,
press the Arrow key to
highlight Select Save Media.

2. Press Enter. The Select Save
Media screen appears.

3. Use   to select
the storage media.

4. Press  to save or   to exit without saving changes.
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Simple Cable ID/AutoName Option

Cable IDs and Test Numbering

Single and Double Cable IDs

There are two levels of AutoName capability: Single and Double ID. The Double
ID feature has several benefits:

• Both ends of the cable under test are clearly identified.

• While reviewing saved test records, potential problems can be identified and
quickly located.

If the Autosave Autotest preference is selected, names will automatically be
assigned to completed tests.

• You can assign a maximum of two unique 10-character cable names for the
cable under test (Double ID).

• The tester defaults to a single naming mode (Single ID). The following three
screens are examples of unique Single and Double Cable IDs.

1. Single ID Example

A unique alphanumeric
character name can be entered,
along with a four-character
incrementing counter field. The
counter is set by default or by
the user. This example is set to
start at 0003.
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2. Double ID “Cable To”
Example

A unique alphanumeric
character name can be entered
along with a four-character
incrementing counter field.
This example is set to start at
0000.

Note: Select  to switch to the
Cable From screen.

3. Double ID “Cable From”
Example

A unique alphanumeric
character name can be entered,
along with a four-character
incrementing counter field.
This example is set to start at
0003.

Note: Select  to switch to the
Cable To screen.

Test Counter

In addition to the cable name, you can assign up to four incrementing characters to
identify individual tests. This input is placed in the Current Value parameter
located just below the Cable Name parameter of the Cable ID screen. The default
numbering scheme is set to start counting from 0000 and end at 9999. Custom
numbering schemes may also be used.
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Opening the Single/Double Cable ID Screen:

1. On the ready screen, select Cable ID  to open the main Cable ID screen.

2. The screen that appears will reflect the most recently assigned Cable ID (either
single or double). To toggle between Single and Double ID screens, position
the cursor over Select Single or Double ID and press Enter.

Single ID Screen Double ID Screen

3. The following options may be selected from the main Cable ID screens:

• Increment Cable ID (Cable From and Cable To in Double ID mode)

• Set Cable ID (Cable From and Cable To in Double ID mode)

• Select either Single or Double IDs for tests.

4. Press  to save changes.

5. Press  to return to the previous screen without saving changes.
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To set a Cable ID:

1. In the Cable ID screen,
highlight Set ‘Cable From’.

2. Press Enter to open the screen.

Note: The screen that appears will
reflect the most recently
assigned Cable ID (either
Single or Double). Double ID is
used in this example.

3. Enter the following parameters
as required:

a. Cable Name, ten characters
maximum.

b. Current Value, four
incrementing characters.

c. Select  to go to the
Cable To screen. Repeat
steps a and b.

4. After entering the desired Cable From and Cable To names and parameters,

press  to save and return to the Main Cable ID screen.
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Changing a Cable Type

The tester comes with several cable types stored in non-volatile memory. When a
cable type is selected, the recommended limits for that cable are automatically
programmed into the tester.

Cable choices are made by cable type:

• Twisted Pair Permanent • Ethernet

• Twisted Pair Channel Link • Custom Cable

• Miscellaneous Types • Fiber

To select a cable type:

1. Press both  and  keys at the same time, or select  located on
the DH Ready screen. The Cable Type screen appears.

2. Press the Up/Down Arrow
keys highlight the desired cable
type.

3. Press Enter to select a cable
type and its associated default
NVP for testing.
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4. Position the cursor on the
desired cable type and press
Enter to accept the new cable
type and its associated default
NVP for testing.

Note: A number of unique cable
manufacturer NVP values are
stored in the tester memory. To
display the list of manufacturer
cables for the currently
highlighted test standard, select

.

5. Select  if you want to
use the selected cable as the
basis for a Custom Cable.  The
tester will display the Custom
Cable screen.
You can then change the
default cable features and save
the cable as a Custom Cable.
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To change the default NVP value:

1. From the Test Standard screen,

select  to change the
NVP.

The NVP screen will appear.

2. To manually enter a new NVP value, use the Arrow keys to highlight and
enter new NVP values.

3. To automatically calculate a new NVP value, select Measure NVP. The
Measure NVP screen appears.

4. Connect a test cable of known length.

5. Using the Arrow and Number keys, enter the known cable length.

6. Select  to calculate a new NVP value. The display returns to the main
NVP screen after the new NVP value has been calculated.

Note: For ISO Standards add 4 meters to the known cable length.
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Custom Cable Settings

All of the cable types pre-programmed into the LANTEK tester are associated
with a predefined test standard. You cannot change these pre-programmed
settings. If you want to run a different set of tests for a given cable you must create
a Custom Cable.

For example, if you would like to run Return Loss in addition to the TIA 568B
Category 5 tests (Return Loss is not a required TIA test), you must create a
Custom Cable and select the tests you want to include in the test suite for this
cable.

A maximum of ten custom cable settings can be created, stored, removed, and
retrieved when needed.

To create a new custom cable type:

1. Press both  and  keys at the same time, or select  located on
the DH Ready screen. The Cable Type screen appears.

2. Press the Arrow keys to
highlight the desired cable type.

3. Press Enter. The Test Standard
screen appears.
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4. Position the cursor over the
desired cable type and select

. The Custom Cable
screen appears.

5. Change the desired cable
settings, then proceed to the
next step, naming the cable.

6. Position the cursor over
Custom Name/NVP and press
Enter. The NVP Screen
appears.

7. Change NVP parameters as
required and then name your
new custom cable.

8. Press Enter to accept the
changes and return to the
Custom Cable screen.
The new custom cable is now
selected as the cable under test.
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To select or delete a custom cable type:

1. Press both  and  keys at the same time, or select  located on
the DH Ready screen. The Cable Type screen appears.

2. Press the Arrow Key to
highlight the Custom Cable
type.

3. Press Enter to open the
Custom Cable screen.

4. The tester displays all currently
stored custom cable types.

5. Position the cursor over the
desired custom cable type.

6. Press Enter to make the
custom cable you highlighted
the new cable type or select

 to delete the selected
custom cable type.
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To edit an existing custom cable type :

1. Press both  and  keys at the same time, or select  located on
the DH Ready screen. The Cable Type screen appears.

2. Press the Arrow Key to highlight the Custom Cable type.

3. Press Enter to open the Custom Cable screen.

4. Select the cable type to be
customized.

5. Press the  soft key.
The Custom Cable parameter
screen appears.

6. Position the cursor on the
desired custom cable parameter
and press Enter to edit the
settings.

7. After making the desired changes, select the Custom Name/NVP option.
The NVP screen appears.

8. Press  to save the cable under its current name or under a new name.

Note: Refer to the next page for a description of custom cable parameter options.
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Custom Cable Parameters

1

3

5

7

2

4

6

Figure 3-4: Custom Cable Parameter Screen

Table 3-5: Custom Cable Parameter Options

Item Parameter Description
1 Frequency Range Use this menu to set minimum and maximum certification

and cable grade frequencies.
2 Connector Pinout This screen is used to define connector pinouts.

Note: If one wire pair is not selected, tests for NEXT,
attenuation, capacitance, DC resistance, and
impedance will not be performed on that pair.

3 Test Limits This screen is used to customize Autotest pass/fail limits.
4 Link Models Custom NEXT and Attenuation limits are set by using a

flat line limit or one of several different models.
Frequency limits will vary from less than 1 to 350 MHz
for the LANTEK 6 and from 1 to 750 MHz for the
LANTEK 7 based on the link type.
For a detailed description of the methods and limits for
calculating NEXT and Attenuation values, refer to
Appendix C, Measurement Methods and Limits.

5 Select Autotests Not all cables will require the full suite of Autotests. Use
this menu to select the Autotests to be performed.

6 Adapters Use this menu to indicate which near-end and far-end
cable adapters are currently being used.

7 Custom
Name/NVP

Use the alphanumeric keys to enter a custom name or
change the NVP parameters. The LANTEK testers can
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store up to 10 custom cables.
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Tone Generator

Both the DH and RH can generate a “low” tone, “high” tone, or “warble” tone
(alternating “low” and “high” tone at 2 Hz rate) that is detectable by most standard
wire tracing amplifiers.

Patch Panel

Wall Outlet

Inductive
Probe

Remote
Handset

Adapter with
2 Meter Patchcord

AUTO
TEST

NET MONITOR

WIRE MAP

TDR

LENGTH

SHIFT

750 MHz Certifier

F1 F2 F3 F4
F5 F6 F7 F8

ENTER

Escape

TALK

ANALYZE

SETUP

HELP

1 2 3

4 5 6

7 8 9

0

ABC DEF GHI

JKL MNO PQR

STU VWX Y Z

SPACE

Display
HandsetOR

Figure 3-5: Typical Tone Generator Setup

Note: The Wiremap, Shift, and Tone buttons are hard keys. Pair A, Pair B, Pair C, Pair
D, Low, High, and Warble are soft keys displayed on the DH.

To activate the Tone Generator using the Display Handset:

1. Connect the DH to the Cable under test.

2. Press both  and 
NET MONITOR

WIRE MAP  at the same time to enter Tone mode.

Note: The Tone mode will remain active until  is pressed or no test activity has
been performed after the past five minutes.

3. Using the soft keys, select the pair (Pair A, Pair B, Pair C, or Pair D) on which
to place the tone.
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4. Select the tone, press 
 
and select LOW, HIGH, or WARBLE using the soft

keys.

To activate the Tone Generator using the Remote Handset:

1. Connect the RH to the cable under test.

2. Press  on the RH to enter Tone mode. The RH two-line display shows
the first line TONE, the second line shows a XY form of characters.

X Character
(Tone Type)

Y Character
(Placement of tone)

L = Low A = Pair A

H = High B = Pair B

W = Warble C = Pair C

D = Pair D

Example: LA = Low tone, Pair A

Note: The Tone mode will remain active until  is pressed or no test activity has
been performed after the past five minutes.

3. Select the pair on which to place the tone by cycling the Tone key.

4. Select the tone for the selected pair by cycling the Tone key.
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Digital Talkset

When the Display Handset and Remote handset establish communication and are
connected by at least one correctly mapped wire pair, the units will support
simultaneous two-way audio communication through an external attached
microphone/headset. The actual communication from one handset to the other is
via a digital data stream and is compatible with fiber optics (via the fiber optic
adapter module).

Audio communication is initiated by assuring that the Talksets are properly
connected and momentarily depressing the Talk button on either the DH or the
RH.

If the wire map supports this, audio communications will be activated. Both the
RH and DH provide visual indication when the Talkset is active. The Talkset will
not function during any type of cable test operation.
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TDR TEST

TDR (Time Domain Reflectometer)

Time Domain Reflectometer is one of the most powerful diagnostic tools available
for metallic cable troubleshooting. While conventional test methods cannot locate
the fault, TDR is used to reveal conditions about a cable that simple Pass/Fail
reports and raw measurements may not show.

The LANTEK tester uses the TDR test to scan the length of a cable for impedance
problems, or to accurately verify the cable length. TDR is not limited to identifying
just shorts or opens; it also points out any disturbances in the cable.

How TDR Works

The TDR function transmits energy into a cable pair, and the returning reflections
are monitored in a manner similar to radar.

• The shape of the reflection identifies a cable deformity, open, short, or
termination.

• The length of time it takes a transmitted pulse to return is used to calculate
cable length.
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Applications of TDR

Cable Inspection

Situation Activity
New Wiring Installation The wiring contractor installs horizontal and

backbone cables/wires in accordance with a
Communication Cable Specification and supplied
blueprints.

Cable Testing All Autotest results are supplied in hard copy and
on disk to the owner.

Final Inspection Contractor and owner conduct final inspection.

Final Acceptance Owner accepts installation.

Office equipment installed by
owner

One of the telecommunications outlets appears to be
faulty.

Owner informs a wiring contractor
of bad cable

The wiring contractor sends a technician out to
investigate.

Technician performs Autotest and
TDR on the failed network drop

A wire pair fails the Crosstalk test. TDR indicates
an anomaly at 100 feet from the patch panel. The
current TDR graph (with anomaly) is saved.

Contractor checks the cable at 100
feet out from the
telecommunications closet

The contractor finds a fire extinguisher mounting
bracket on the cubicle wall. A bracket mounting
screw has damaged the cable jacket.

Owner is informed that the
problem is not related to a faulty
cable or installation

Repairs can be authorized by the owner. The
contractor will invoice time and materials.
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How to Perform a TDR Test

Prior to running the TDR, connect the LANTEK DH to the cable or link to be
tested.

Test Setup

1. Select the Cable Type (Refer to Chapter 3, Changing a Cable Type)

Note: All TDR numerical information is derived from the data in the cable database.

2. Calibrate and configure the tester as required (Refer to Chapter 3, Calibration
and Configuration sections).

Note: The tester retains the last configuration settings. Configuration settings must be
adjusted if one or more settings have changed.

3. Disconnect the cable to be tested from all network equipment.

4. Connect the required test lead to the Display Handset and to one end of the
link (TDR does not require a Remote Handset). Refer to Figures 7-3 and 7-4,
for Permanent and Channel Link connections.

5. Press  to power up the Display Handset
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Performing a TDR Analyze Function

1. From the Ready screen, select

Analyze .
The Analyze screen appears.

2. Press the Arrow keys to
highlight the TDR function.

3. Press Enter to start the TDR
test. Once started, the TDR
automatically runs in the
continuous mode.

Note: When TDR is running, relays
will be heard clicking in the
Display Handset.
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4. At the completion of the TDR
test, a graph is displayed.

Note: The TDR function is not
available through custom cable
settings.

The TDR Plot

The TDR graph is an image of the structure of the cable under test along its entire
length, up to a limit of 2000 feet (609.6 meters). This graph shows anomalies by
displaying blips, peaks, or valleys on an otherwise flat line.

TDR Plot Layout and Controls

The horizontal axis represents distance data and the vertical axis represents the
percentage of reflection.
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Figure 3-6: TDR Graphical Plot Layout and Controls

Note: TDR graphs do not have a tabular view option

Table 3-6: TDR Graphical Plot Layout and Controls

Item Function
1 Actual TDR data plot for a wire pair. When a wire graph is first

displayed, the cursor is automatically positioned at the midpoint of
the data.

2 Designated wire pair plotted from TDR data. (Pair A, B, C, or D)

3 Distance in meters or feet and impedance value at the cursor.

4 The vertical axis representing percentage of reflection data.

5 The horizontal axis representing distance data.

6 Distance of cursor vs. total length measured in points and associated
measured levels of impedance.

7 Zoom out/Zoom in keys to expand or compress the horizontal axis of
the graph at the cursor.

8 Arrow keys are used to move the cursor horizontally; the screen data
displayed will change to reflect the cursor position.
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Viewing TDR Results

When the TDR diagnostic function is first started, the graphical plot is
automatically scaled to the full length of the cable. A maximum of 2000 feet (609.6
meters) of cable results can be displayed on a TDR graph.

When TDR is first activated, the left 10% of the graph displays prelaunch
impedance signal rise distance data and the right 10% of the graph displays
reflection data.

• Press the Left/Right Arrow keys to move the cursor horizontally. As the
cursor moves, screen data displays will change to reflect cursor position.

• Press the Up/Down Arrow keys to view TDR results from a different wire
pair. The TDR test runs one time and displays the results.

• Press the Zoom keys to scale the graph. At the maximum or minimum limits
the key becomes inactive.

• TDR results can be saved to a PC and printed.

Interpreting TDR Results

Always note the cable pair currently being displayed. The shape of the reflections
plotted for the pair can be used to identify and locate problems. If the cable pair
has no problems along the entire length of the pair, then the graph will appear as
follows:

• The graph has an upswing point on the left most 10% of the display (Start of
the Cable).

• The following 80% of the graph is relatively flat.

• The graph has an upswing or downswing point on the right most 10% of the
graph (End of the Cable).
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Evaluating a TDR Graph

When evaluating the TDR graph, the first consideration should be the average
impedance of the cable being tested:

• A graph with sharp dips or spikes can identify anomalies.

• For subtle problems, interpretations should be based on benchmark data
obtained from the analysis of many cable segments.

When anomalies are detected in the cable pair, the cursor is automatically placed
on the first anomaly. Press the Arrow keys to position the cursor on the anomaly
of interest. Impedance and distance values will be displayed on the screen.

The following troubleshooting tips identify typical cable conditions and their
corresponding screen plots.

Condition TDR Plot Indication
Open, Near End Upswing develops early. In comparison to good cable

pairs, this pair appears shorter in length.

Short, Near End Downswing develops early. In comparison to good
cable pairs, this pair appears shorter in length.

Open, Far End Fully developed upswing at the Far End.

Short, Far End Fully developed downswing at the Far End.

Split Pair 20% to 30% rise in relative impedance at the split with
a corresponding drop in impedance where the pair is
reconnected.

Cable segment with higher than
nominal impedance

Peak in the level area of the plot.

Cable segment with lower than
nominal impedance

Dip in the level area of the plot.

Level Plot, much higher than the
known cable NVP

Wrong cable type selected, or wrong cable type
installed.

No distinct upswing or
downswing at the Far End

Matched terminator attached to the cable. The pair
appears to have a very long length.
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Storing, Retrieving, and Deleting TDR Results

Storing a Graph

The TDR results can be stored in the Current Job.

1. Press the Up/Down Arrow keys to select the desired cable pair graph.

2. Select . The Save Test screen appears.

3. The test name is automatically assigned. If a different name is desired, use the
Delete key to change the highlighted character(s).

Note: The default Save As… name is derived from the cable name entered into the
Cable ID screen, or from the previous saved name.

4. When you have entered the name, press Enter to accept the changes and
return to the ready screen.

Retrieving or Deleting a Graph

For detailed instructions regarding retrieving or deleting stored TDR results, refer
to Chapter 4, Viewing or Deleting Stored Autotest Results.
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Chapter 4
Autotesting

Contents

• Autotest Overview

• Autotest Preferences

• Running Autotest

• Interpreting Autotest Results

• Autotest Graphs

Autotest Overview

Autotest is the easiest and quickest way to measure and verify your cable
installation. When the Autotest key is pressed, the LANTEK tester automatically
performs a series of pre-programmed tests. These test suites are pre-determined
based on either adopted or proposed standards as well as specific parameters.
After all tests have been completed, the tester displays a single overall pass/fail
result and individual test pass/fail results.

Autotests are performed with the Display Handset (DH) and Remote Handset
(RH) connected at opposite ends of the cable under test.

Test Suites

The tests run during an Autotest depend on the cable type selected (refer to
Chapter 3, Changing a Cable Type).

• Autotest can be preset to automatically save test results immediately following
each suite of tests, or results can be saved and printed manually. To preset
these functions, see Autotest Preferences in this chapter.
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• Individual sub-tests can be selected and viewed with more detailed data
following completion of the Autotest using the Autotest Results screen.

Table 4-1: Preset Autotest Suites Available for Specific Cable Types

CABLE TYPES
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TWISTED PAIR PERMENANT
CAT 5e,  UTP/STP Prem

(TIA/EIA568B - Permanent/Channel)
•• •• •• •• •• •• •• •• •• •• •• ••

CAT 6-250,  UTP/STP Prem
(TIA/EIA568B, Permanent/Channel)

•• •• •• •• •• •• •• •• •• •• •• •• •• •• ••

(prop.) D,  UTP/STP Perm
 (ISO/IEC 11801-2.Edition)

•• •• •• •• •• •• •• •• •• •• •• •• •• ••

(prop.) D,  120 ohm, UTP/STP Perm
 (ISO/IEC 11801-2.Edition)

•• •• •• •• •• •• •• •• •• •• •• •• ••

ISO Class E,  UTP/STP Perm
 (ISO/IEC 11801-2.Edition)

•• •• •• •• •• •• •• •• •• •• •• •• •• ••

EN50173.A1 Class D,  UTP/STP Perm
(CENELEC)

•• •• •• •• •• •• •• •• •• •• •• •• •• ••

Nexans LANmark D,  UTP/STP Perm •• •• •• •• •• •• •• •• •• •• •• •• ••
Nexans LANmark E,  UTP/STP Perm •• •• •• •• •• •• •• •• •• •• •• •• •• •• ••
Nexans Epsilon E,  UTP/STP Perm •• •• •• •• •• •• •• •• •• •• •• •• •• •• ••
Nexans Class D,  UTP/STP Perm •• •• •• •• •• •• •• •• •• •• •• •• ••
TWISTED PAIR Basic
CAT 3,  UTP Link

(TIA/EIA568B)
•• •• •• ••

CAT 5,  UTP/STP Link
(TIA/EIA568B)

•• •• •• ••

CAT 5 Gbit,  UTP/STP Link
(IEEE 802.3z)

•• •• •• •• •• •• ••

ISO Class C,  UTP/STP Link
(ISO/IEC  11801 – 1.Edition)

•• •• •• •• •• •• •• •• •• ••

ISO Class D,  UTP/STP Link
(ISO/IEC  11801 – 1.Edition)

•• •• •• •• •• •• •• •• •• ••

ISO Class D 120 ohm,  UTP/STP Link
(ISO/IEC  11801 – 1.Edition)

•• •• •• •• •• •• •• •• ••

TP-DDI,  STP Link •• •• •• •• •• •• •• •• •• ••
TPPMD,  UTP Link •• •• •• •• •• •• •• •• •• ••
AS/NZS C,  UTP/STP Link •• •• •• •• •• •• •• •• •• ••
AS/NZS D,  UTP/STP Link •• •• •• •• •• •• •• •• •• ••

(Table Continues)
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Table 4-1: Preset Autotest Suites Available for Specific Cable Types (Continued)

CABLE TYPES
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TWISTED PAIR Channel
CAT 3,  UTP Channel

(TIA/EIA568B)
•• •• •• ••

CAT 5,  UTP/STP Channel
(TIA/EIA568B)

•• •• •• ••

CAT 5 Gbit,  UTP/STP Channel
(IEEE 802.3z)

•• •• •• •• •• •• ••

CAT 5e, UTP/STP Channel
(TIA/EIA568B.1)

•• •• •• •• •• •• •• •• •• •• •• ••

CAT 6-250,  UTP/STP Channel
(TIA/EIA568B.2.1)

•• •• •• •• •• •• •• •• •• •• •• •• •• •• ••

ISO Class C,  UTP/STP Channel
(ISO/IEC 11801 – 1.Edition)

•• •• •• •• •• •• •• •• •• ••

ISO Class D,  UTP/STP Channel
(ISO/IEC 11801 – 1.Edition)

•• •• •• •• •• •• •• •• •• ••

ISO Class D 120 ohm,  UTP/STP Channel
(ISO/IEC 11801 – 1.Edition)

•• •• •• •• •• •• •• •• ••

(prop.) ISO Class D,  UTP/STP Channel
(ISO/IEC 11801 – 2.Edition)

•• •• •• •• •• •• •• •• •• •• •• •• •• ••

(prop.) ISO Class D 120 ohm,  UTP/STP Channel
(ISO/IEC 11801 – 2.Edition)

•• •• •• •• •• •• •• •• •• •• •• •• ••

ISO Class E,  UTP/STP Channel
(ISO/IEC 11801 – 2.Edition)

•• •• •• •• •• •• •• •• •• •• •• •• •• •• ••

TP-DDI,  STP Channel •• •• •• •• •• •• •• •• •• ••
TPPMD,  UTP Channel •• •• •• •• •• •• •• •• •• ••
AS/NZS C,  UTP/STP Link •• •• •• •• •• •• •• •• •• ••
AS/NZS D,  UTP/STP Link •• •• •• •• •• •• •• •• •• ••
EN50173.A1 Class D,  UTP/STP Channel

(CENELEC)
•• •• •• •• •• •• •• •• •• •• •• •• •• ••

(Table Continues)
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Table 4-1: Preset Autotest Suites Available for Specific Cable Types (Continued)

CABLE TYPES
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MISC. TYPES
Local Talk •• •• •• •• ••
ISDN •• •• •• •• •• ••
Bavaria STP Link •• •• •• •• •• •• •• •• •• ••
AUTOMATCH •• •• •• •• •• •• •• •• ••
ECOMATCH •• •• •• •• •• •• •• •• ••
FOILTEK •• •• •• •• •• •• •• •• •• ••
PAIRTEK •• •• •• •• •• •• •• •• •• ••
Single Pair •• •• •• ••
USOC •• •• •• •• •• •• ••
IBM Coax •• •• ••
Twinaxial •• •• ••
Arcnet •• •• ••
CATV •• •• ••
VW STP Link •• •• •• •• •• •• •• •• •• ••
CAT 6-200,  UTP/STP Channel •• •• •• •• •• •• •• •• •• •• •• •• •• •• ••
CAT 6-200,  UTP/STP Link •• •• •• •• •• •• •• •• •• •• •• •• •• •• ••
ETHERNET
10BASE T (IEEE 802.3) •• •• •• •• •• ••
10BASE 2 (IEEE 802.3) •• •• ••
10BASE 5 (IEEE 802.3) •• •• ••
100BASE T Basic Link •• •• •• ••
100BASE T Channel •• •• •• ••

Note: For a detailed test description, refer to Chapter 7, Cable Testing Fundamentals.
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Test Setup

1. If the LANTEK tester has not been calibrated in the past 7 days, it is
recommended that you perform a field calibration (Refer to Chapter 3,
Calibrating the Tester).

2. Configure the tester as required (Refer to Chapter 3, Configuring the Tester):

• Enter User Information • Set Date & Time

• Set Autotest Preferences • Select Display Language

• Adjust Display Contrast • Restore Factory Defaults

• Set Time-out Options • Pack Memory

• Set Measurement Units • Clear Memory

• Configure the PC and Printer I/F • Select Save Media

• Configure the Talkset Option

Note: The tester retains the last used configuration settings. You only need to set
configuration options if one or more parameters have changed.

3. Select the Cable Type (Refer to Chapter 3, Changing a Cable Type).

4. Disconnect the cable to be tested from all network equipment.

5. Connect the Adapters to both handsets.

6. With the appropriate patchcords, connect the Display Handset patchcord to
one end of the link and the Remote Handset patchcord to the opposite end
(Refer to Chapter 7, Permanent and Channel Link Test Setup)

7. Power up the Display Handset by pressing the On/Off key.

Note: The Remote Handset will be powered up automatically by the Display Handset
when the Autotest begins. LANTEK Channel Adapters and patchcords are
used for both Permanent Link and Channel Link testing. The LANTEK unit will
set the Reference Plane and Test Limits according to the type of test selected.
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Test Sequence

When the Autotest button  is pressed, the following actions occur:

1. The DH will first attempt to communicate with the RH (Remote Handset)
using one correctly wired pair. If it is unable to establish communication, the
DH will display a message that it is looking for the RH and continue trying
until the Autotest is manually canceled or the RH is found.

2. Once communication with the RH is established, its serial number is checked to
see if current field calibration data exists. If a field calibration has not been
performed in the last 7 days with the RH unit, the Autotest will be aborted and
a Calibration Required message will display.

3. If the serial number is valid, the DH will proceed with the specified Autotest.
The first test performed in most Autotests is the Wire Map for twisted pair
cable types.

4. After running the Wire Map test, Autotest runs the remaining tests specified
for the currently selected cable type. You have the option of specifying (in
Autotest Preferences) that testing halt after any failed test or proceed through
the entire Autotest regardless of test failures.

Note: All tests after Wire Map will only be performed on valid wire pairs.

5. Once an Autotest has been completed, all of the test data can be reviewed,
saved, and printed.

• The test results for the last Autotest are held in non-volatile memory and
available for review or storage, even after power is cycled off and back on.

• The last Autotest results remain in non-volatile memory until they are
replaced by new test results or the memory is cleared.
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Autotest Preferences

Setting your Autotest Preference Options

1. On the Ready screen, select

Preferences . The
Preferences screen appears.

2. Select Autotest Preferences.
The Autotest Preference screen
appears.

3. Press the Arrow keys to
highlight the desired option.

4. Select  to activate or
deactivate an option.

5. Press  to accept the
selected Autotest Preferences.

6. Press  to exit this screen
without making changes
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Running Autotest

Autotest performs comprehensive tests using programmed testing limits. An
overall pass or fail is displayed along with individual test results.

Before beginning Autotesting, connect the Display and Remote handsets to the
cable or link to be tested.

1. Press Autotest .

2. If the RH unit is not found, a Searching for Remote Handset warning
message is displayed on the DH.

Press  to cancel the test and return to the Ready screen.

3. If the RH is found, Autotest compares the cable test readings to standards for
the cable type selected and issues pass/fail statements for each test.

4. While Autotest is in progress,
an hour glass displays test
progress and indicates pass or
fail for each completed test.

Note: Press and hold the  key
prior to Autotest completion to
stop an Autotest after
completion of the test in
progress.
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5. When the Autotest is
completed, an overall result of
pass or fail is displayed at the
top right of the test information
columns.

Results for individual tests are
displayed opposite each test
name.

6. To begin the next Autotest, press Autotest .

7. If results from the current test have not been printed, or you did not have
AutoSave enabled in the Autotest Preference screen, you will be prompted to
discard or save the current test results before the next Autotest will run.

Note: The tester also performs real time Analyze testing that enables you to troubleshoot
problem areas. If Autotest results indicate a failure, refer to Chapter 5, Analyze
Testing.
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Interpreting Autotest Results

Pass/Fail Reporting

The overall Autotest result is
displayed at the top right of the
Autotest display screen. Individual
Autotest results are displayed to
the right of each test.

Table 4-2: Overall Test Result Symbols

Symbol Overall Autotest Result
Overall test result is a pass if each individual test is a pass or a pass*.

Overall test result is a fail if one or more individual test is either a fail or a
fail*.

Table 4-3: Individual Autotest Reports

Symbol Individual Autotest Result
Pass

All values pass with sufficient margin.
* Pass*

All values pass, but one or more test values passed by a margin smaller
than the unit’s specified accuracy for the measurement.

The pass* result does not fail the cable. However, it is a warning that the
cable is close to the limit on that parameter and should be inspected as
soon as possible.

(Table Continues)
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Table 4-3: Individual Autotest Reports (Continued)

Symbol Individual Autotest Result
Fail

One or more values fail by a margin of failure greater than the unit’s
specified accuracy.

* Fail*

One or more values fail, but the margin of failure is smaller than the unit’s
specified accuracy for the measurement.

The fail* result fails the cable and must be cleared up, just like a standard
fail. However, fail* means it has failed by a small margin and minor
adjustments in the installation may correct the error.

The effect of pass*/fail* reporting of individual test results is to provide a built-in
margin of safety above and below the advertised accuracy for a measurement.
Measurements which fall outside this guard band are a clear pass or a clear fail,
and the probability of the tester being in error is extremely small.

Note: If you do not want to see marginal test results, deactivate the setting in the
Preferences menu, AUTOTEST sub-menu details.
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Viewing Current Autotest Results

Autotest results can be viewed at the completion of the test sequence or saved for
later viewing.

1. Press the Arrow keys to
highlight the desired test.

2. Press Enter to view test
results.

3. When finished, press  to return to the Autotest screen.
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Understanding Test Failures

A failure result for Autotest indicates that one or more tests did not meet minimum
cable parameter levels for the cable type selected.

Note: Be sure that you have selected the correct cable type and are using appropriate
connectors and links.

Identifying which tests failed and the characteristics of the failure will determine
the type of fault. If the Autotest shows a failure on a particular sub-test, perform
Analyze testing (see Chapter 5) for the failing test in order to troubleshoot the
cable.

When more than one test fails on Autotest, the test order used for troubleshooting
is an important element in eliminating the source of the problem.

If any tests fail, Analyze tests should be performed in the following order:

1. Wire Map

2. DC Resistance

3. Length

4. Delay and Skew

5. Impedance

6. Attenuation

7. NEXT

8. Dual Return loss

Refer to Chapter 5, Analyze Testing to run these tests.
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Using Jobs to Store Test Results

The LANTEK tester can store cable test results under separate Job names. You
can create Jobs, assign any name to them, and store test results on a Job-by-Job
basis. By using Jobs, you can logically group and store test results in a descriptive
manner.

You can set up a separate Job for each floor in a building, each building on a
campus, each customer, or for any other user-defined classification.

To create a New Job:

1. On the Ready screen, select

Stored Results  Press
Enter. At this point, you will
see a list of all the jobs which
are currently available. If you
have never created a Job, the list
will be empty.

2. To create a new Job select

. The Job Options
screen appears.
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3. Press the Arrow keys to select
New Job. Press Enter. The
New Job screen appears.

4. Type a name into the text field
on the New Job screen using the
alphanumeric keyboard. Press a
key second or third time to
select the second or third
character on the key.

Press the Right Arrow hard key
to advance to the next character
position.

Note: Use the soft keys to correct a highlighted character.

5. After entering the name, press Enter, returning to the Job Options screen
where you can Access Job information, Delete Jobs, Rename Jobs, make a Job
the current Job, or create more Jobs. The new active job name is displayed at
the top left corner of the display.

Note: When you save test results, they will be stored in the last Job you made current.
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Saving Current Autotest Results

A maximum of 6,000 TIA Cat 5e individual Autotest results can be stored in the
LANTEK internal tester memory and accessed later using the Test Results menu.
Autotest results can be saved immediately following the test.

• Only overall passed Autotests can be automatically saved.

• The entire set of test results is saved as one file.

• Test results are automatically saved if the AutoSave preference is enabled.
Refer to Setting Autotest Preferences in this chapter.

• Test names are automatically assigned to completed tests. If a different name is

desired, a test can be named manually using .

Note: The user can either store the results in the internal memory or on the compact
flash card.

To save Autotest results (AutoSave Disabled):

1. To manually save an Autotest, press the Save key.

2. The Test Saved screen will be displayed for a brief period, showing the name
the test is saved under.

3. If the current name already exists, a warning screen appears asking you to
overwrite the currently existing file or rename the results to another file or new
file name.

4. Press  to exit and return to the previous screen without performing a save

operation, or select  to overwrite the existing file.
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5. Select  to rename the current test. The Save Test screen will appear
with a new name option.

Note: The default Save As… name is derived from the cable name entered into the
Cable ID screen, or from the previous saved name.

6. Press Enter to accept the change and return to the Test Results screen.

Viewing or Deleting Stored Autotest Results

Test Results contain stored data from Autotest up to 6,000 Autotests can be
stored in internal memory. You can view, print, delete or rename these files.

When an Autotest or an individual test from Analyze is saved, the data is stored
with a unique name. Test results can be viewed, printed, or deleted from the
Stored Results screen.

1. On the Ready screen, select

Stored Results  to open
the Job List screen.

2. Highlight the desired Job.

3. Select  to choose the
desired Job.

4. Select  to open the
Options screen.
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5. Press the Arrow keys to
highlight the desired selection.

6. Press Enter to perform the
desired option.

7. Press Escape at any time to
return to the previous screen.

Job and Test Option Tables

Table 4-4: Job Options

Option Description

Current Job Info Total number of tests passed/failed, cable length,
and headroom for current job.

All Job Info Total number of tests passed/failed, cable length,
and headroom for all jobs.

Delete Selected Jobs Deletes selected jobs from memory.

Rename Job Change name of currently selected job.

New Job Add new job to job list.

Make Job Current Activate highlighted job.  Saved tests
(Autotests/Analyze) will be stored in this test.

Undo Delete Jobs Undo last delete action.
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Table 4-5: Test Options

Option Description

Select All Select all stored test results.

Select All Passed Select only passed tests for processing.

Select By Date Select stored test results by date.

Select All Failed Select only failed tests for processing.

De-select All Unmark all stored test results.

Print Selected Print selected test results.

Print All Print a summary of stored test results.

Undo Deleted Tests Undo the last delete action.

Delete Selected Delete marked test results.

Delete All Delete all stored test results.

Result Info Display test result information such as number of
tests, number passed and failed, length tested, and
headroom.

Selected Result Info Display the results of selected tests.

Rename Rename a selected test result.

Note: The functions indicated above will only be performed on tests stored in memory.



Chapter 4
Autotesting

4-20

Autotest Graphs

Autotest results can be viewed at the completion of the test sequence in either a
tabular or graphical format.

Tabular Format Graphical Format

Graphing Facts

Graphs can be very useful for viewing test results. There are a few things you need
to know before you start using them:

• In Autotest Preferences, you can set your tester to include and save graphs
with test results. (Save Graphics is the factory default.)

• To save Autotest Results and graphs, use external storage media (Flash Card
and/or PC)

• The limit and worst case margin parameters are always displayed at the bottom
of the tabular test screen.

• When you go to graph view, the vertical cursor is always placed at the worst
case margin location.
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To view an Autotest graph:

1. Configure the Autotest Preferences (Refer to Page 4-9).

2. In Autotest Preferences, make sure the Save Graphs checkbox is selected.

3. Press Autotest. Upon
completion of the test suite for
the cable type selected, the
Overall Autotest results screen
displays.

4. To display tabular data,
position the cursor on the
desired test result (the NEXT
test) and press Enter.

5. To display a graph of the
tabular data, position the
cursor on the tabular data of
interest (pairs 7,8 and 3,6) and
press Enter.

6. The graph will always open
with the cursor positioned on
the worst case margin. In this
example, the cursor is
positioned on the horizontal
axis at 99.50 MHz.

7. Press  to return to the previous screen.



Chapter 4
Autotesting

4-22

Graph Formats, Layouts, and Controls

Graphs are useful for observing the relationship between two network cable
parameters, actual measured parameters and predefined worst case margins.

There are two different graph formats: single and dual plot.

Single Plot Dual Plot

Layout and Controls

The horizontal axis represents frequency data and the vertical axis represents the
measure values in dB, with limits indicated as a solid line trace.

Tabular View Graphical View

Figure 4-1: Tabular Data and Graphical Plot Layout
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Note: The margin data at the bottom right of the Tabular screen represents the worst
case difference between the actual measured data and the predefined limit
threshold as shown by the cursor position in the graph on the right.

Table 4-6: Autotest Graph View Layout and Controls

Item Function

1 Wire pair plotted from tabular data.

2 The horizontal axis represents frequency data.

3 The vertical axis represents measurements in dB.

4 When a wire pair graph is first displayed, the cursor is automatically positioned
at the worst case limit and frequency point.

5 Actual data plot for a wire pair. Attenuation is plotted in this example.

6 Predefined worst case limit plot for attenuation.

7 Predefined worst case limit plot for NEXT.

8 Actual data plot for a wire pair. NEXT is plotted in this example.

9 Expands or compresses the horizontal axis of the graph. At full magnification,
this key becomes inactive.

10 Arrow keys are used to move the cursor horizontally. As the cursor moves,
screen readouts will change to reflect cursor position.

Moving the cursor:

• Use the soft keys to move the cursor in larger steps.

• Use the key pad keys to move the cursor in small steps.
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Chapter 5
Analyze Testing

Contents

• Analyze Single Test Mode Overview

• Running a Single Test

Analyze Single Test Mode Overview

Analyze mode allows you to troubleshoot by running individual tests, making
adjustments, and observing changed test results. For example, a failed capacitance
measurement can indicate crimped or stretched cable. With Analyze testing, you
can walk the cable and check for damage and stretching. Freeing the cable at
suspected problem areas should improve the measured reading.

Depending on the cable type and defined test standard, any or all of the following
individual tests are available:

• Wire Map • Resistance • Length

• Capacitance • NEXT • Attenuation

• ACR • Return Loss • Impedance

• Delay and Skew • Power Sum NEXT • Power Sum ACR

• Headroom • Power Sum ACR • Power Sum
ELFEXT

• TDR
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Analyze Test Descriptions and Availability

For an overview of individual tests, refer to Chapter 7, Cable Testing
Fundamentals. The individual tests you can run depend upon the cable being
tested. Test availability is pre-determined based on the adopted or proposed
standards (See Chapter 4, Test Suites, Table 4-1).

Test Setup

1. If the LANTEK tester has not been calibrated in the past 7 days, perform a
field calibration (See Chapter 3, Calibrating the Tester).

2. Configure the tester as required (See Chapter 3, Configuring the Tester).

Note: The tester retains the last used configuration settings. You will need to set
configuration options if one or more parameters have changed.

3. Select the Cable Type (See Chapter 3, Changing a Cable Type).

4. Disconnect the cable to be tested from all network equipment.

5. Connect adapters and patchcords to both the Display and Remote Handsets
using the connectors.

6. Connect the Display Handset patchcord to one end of the link and the Remote
Handset patchcord to the opposite end.

Note: Refer to Chapter 7, Figures 7-3 and 7-4, for connections to complete Permanent
and Channel Link testing.

7. Power up the Display Handset by pressing the On/Off key.

Note: The Remote Handset will be powered up automatically by the Display Handset
when the Analyze testing begins.
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Test Sequence

When an individual test is running, the following actions occur:

1. If the test requires the RH (Remote Handset), the DH will first attempt to
communicate with the RH. If it is unable to establish communication, the DH
will display a message that it is looking for the RH and continue trying until the
Analyze test is manually canceled or the RH is found.

2. Once communication with the RH is established, its serial number is checked to
see if current field calibration data exists. If a field calibration has not been
performed in the last 7 days with this RH, an appropriate Calibration
Recommended message will display.

3. If the serial number is valid, the DH will proceed with the specified individual
test.

4. If the test does not require the RH, the DH will run the test and display test
data.

5. Once a test is completed, the test data can be reviewed or printed.

Analyze Test Screens

There are a total of 16 Analyze test screens. They are identical to the
corresponding Autotest screens, with the addition of the Start key located in the
soft key option row. When this key is pressed, the tester begins continuous
execution of the selected test. The Escape key or Cancel key is used to end the
test in progress.

Analyze Test Limitations

Analyze and Autotest test limitations are identical. For a description of test limits
and ranges refer to Appendix C, Measurement Methods and Limits.
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Running a Single Test

Before beginning Analyze testing, connect the Display and Remote Handsets to the
cable or link to be tested.

All Analyze tests are performed using the following procedure:

1. In the Ready screen, select Analyze  to open the Analyze screen. The
Analyze screen lists the tests that can be performed on the currently selected
cable type (refer to Chapter 3, Changing a Cable Type).

2. Press the Arrow keys to highlight the desired test.
In this example, the Length test is selected.
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3. Press Enter to start the test.

4. Upon test completion, the tabular results screen is displayed.
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Interpreting Analyze Test Results

Pass/Fail Reporting

The overall Analyze test result is displayed below the Title Bar at the top right of
the display screen. Individual wire pair test results are displayed to the right of
each test.

In the example above, the Length test results screen is displayed.

• An overall test result of pass or fail is displayed at the top right below the date.

• Individual wire pair test results are displayed in the last column on the right
(Result column).

Overall and Individual test result reporting is usually identical to Autotest mode.
For a description of symbols and test results, refer to Chapter 4, Pass/Fail
Reporting.

Printing Analyze Test Results

A tabular test result screen can be sent directly to a serial printer. Before sending a
result screen to the printer, the printer port needs to be configured. For detailed
printer setup and screen printing instructions, refer to Chapter 4, Printing Current
Test Results.
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Analyze Graphs

Certain Analyze test results can be viewed at the completion of the test sequence
in either a tabular or a graphical format.

1. Run an Analyze test.

2. Position the highlighted cursor on the desired table data.

3. Press Enter to display the wire pair table data as a graph.

Analyze graphs are similar to Autotest graphs. For a description of these graphs,
refer to Chapter 4, Graph Formats, Layout, and Controls.
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Chapter 6
Using LANTEK REPORTER

Contents

• System Requirements

• LANTEK Reporter Installation and Startup

• Tester to PC Connectivity

• LANTEK Reporter User Interface

• LANTEK Reporter Help System Overview

• Uploading DH Tests to the PC

• Utilizing Graph Data

• Working with Databases

• Working at the Job Level

• Working at the Test Level

• Backing Up and Restoring Databases

• Producing and Printing a Report
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System Requirements

Your PC should have the following capability:

Minimum Pentium 90, Windows 95B, 32 MB RAM, 100 MB of
Available disk storage, one serial communications port,
video card cable of providing resolution of 1024 x 768 and
an inkjet printer.

Recommended Pentium 300 MHz, one of the following (Windows 98, ME,
XP, 2000, or NT SP5),128 MB RAM, 100 MB available disk
storage, video card cable of providing resolution of 1024 x
768 a laser printer and an available USB port.

Note: Windows 95 and Windows NT SP4 do not support USB connections. Uploading
test results is therefore limited to a serial port connection.

LANTEK Reporter Installation and Startup

LANTEK Reporter Upgrades

The CD supplied with your tester may not contain the latest version of the
LANTEK Reporter program. IDEAL INDUSTRIES provides a World Wide Web
(WWW) site for LAN cable test products that allows you to use a PC and modem
to obtain the latest LANTEK Reporter maintenance release. Refer to Appendix B,
World Wide Web Services.
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Installation Procedure

The LANTEK Reporter software is installed using the standard Windows 95, 98,
ME, XP, 2000, NT up to SP6 program installer.

1. Insert the LANTEK Reporter CD-ROM.

2. Click on the Start button, and then click Run.

3. Type, d:\ setup

Note: If your CD-ROM drive is not the “d” drive, replace “d” with the correct drive
letter.

4. Follow the instructions on your screen.

Note: Install the LANTEK Reporting System in the default directory, c:\…\ LANTEK
Reporter. An empty database will be created in c:\…\ LANTEK Reporter \db.

Figure 6-1: Typical Installation Window



Chapter 6
Using LANTEK REPORTER

6-4

Starting the LANTEK Reporter Program

There are two ways to start the LANTEK Reporter program:

1. From the Windows desktop, select LANTEK Reporter .

2. From the Windows desktop select Start. Then, select Programs, LANTEK
Reporter.

Tester to PC Connectivity

PC Cables

Use the cables supplied with your tester either the USB or the Serial Port
Interface.

Serial Port Interface Cable

The serial cable, commonly referred to as a Null modem cable, connects to the
RS232 serial port and is capable of uploading data (test results) to the PC or
laptop as well as establishing a connection to a serial port printer for printing.

If you supply your own serial port cable, it must be wired to the specifications
shown in Figure 6-2.
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Figure 6-2: PC Uploading Cable Pinout

USB Interface Cable

The USB (Universal Serial Bus) interface cable is supported by Windows 98, ME,
XP, and NT (SP5 and SP6) operating systems and can upload data approximately
20 times faster than uploads via the serial port. The USB provides the same
functionally provided by the serial port except printing.
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Establishing a Connection

AUTO
TEST

N E T  M O N I T O R

WIRE MAP

TDR

LENGTH

SHIFT

750 MHz Certifier

F1 F2 F3 F4
F5 F6 F7 F8

ENTER

Escape

TALK

ANALYZE

SETUP

HELP

1 2 3

4 5 6

7 8 9

0

ABC DEF GHI

JKL MNO PQR

STU VWX Y Z

SPACE

Serial

or

USB

Figure 6-3: PC to Tester Connections

1. Attach the cable to the tester and an available serial port or USB port on the
PC or Laptop.

2. Turn on the tester.

3. Start the LANTEK Reporter program on the PC or Laptop.

4. From the File Menu, select Upload From Tester…or select  on the
toolbar. The upload process can be performed either by Serial or USB
connection from the Display Handset directly into the PC or laptop. The
upload process can also be performed through the USB flash card reader as a
data storage device if a compact flash card is used for storage of test results.
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5. Select the appropriate preferences and Click OK.

For a serial port connection that is not responsive:

1. Go to the LANTEK Reporter Options menu and select the Tester ID
command.
The program will automatically scan the available communications ports and
baud rates to locate and identify the attached Tester. If the tester is not
identified, proceed to the next step.

2. Some PCs may have difficulties with this function and the following dialog box
displays. Click OK.
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3. Click on the Options menu and select the Serial Port command. Select the
correct Port and match the Baud Rate to that of your LANTEK tester.

4. After you have entered the values, click the Test button. If the Tester is
identified, its serial and model numbers will be displayed.

5. Click OK.

Note: If you have tried alternative baud rates and ports and LANTEK Reporter still cannot
find the Tester, call IDEAL INDUSTRIES Customer Support.

LANTEK Reporter User Interface

The Menu Bar

The menu bar at the top of the screen displays the pull-down menu names.

When you choose a menu, a list of commands drops down under the menu. You
can choose only the commands that are solid black. Gray commands or options are
disabled or may be context-sensitive. For example, to use test commands such as
Find Test and Select Test, the cursor must be in the test grid portion of the screen
or the commands are not available.

To open a menu

1. Move the mouse so that the tip of the mouse pointer is on the desired menu.

2. Click the left mouse button, or press and hold the Alt key and then the
underlined letter in the menu name.
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The File menu

Many of the selections on this menu are standard Windows options.

Command Description

New Create a new database.

Open Database Open an existing database. More than one
database can be open at the same time.

Save Database Save the currently open database

Close Database Close the currently open database.

Upload From Tester Pull result data from the LANTEK tester.

Pack Tester Memory Erase all tests in the tester memory that are
marked for deletion.
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Command Description

Erase Tester Memory Erase all tests in the tester memory.

Upgrade Tester
Firmware

Copy new firmware code to the tester.

Configure Tester Run the configuration wizard to customize
tester’s operating parameters. (Future
enhancement)

Export Export test results as Comma-Separated
Values (CSV) or standard ASCII text files.

Page Setup Modify the print settings.

Headers and Footers Insert notes and company logos.

Print Print a report.

Backup Database Archive current data in the current folder.

Restore Database Restore a closed database from a zipped
archive file into the current folder.

Re-Index Database Re-index the database.

1., 2., 3., 4.  List List the last four accessed databases.

Exit Exit the application.
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The Edit Menu

Click Edit to display the Edit pull-down menus.

Job View

Command Description

Add Job Add a Job.

Edit Job Modify a Job.

Delete Delete a job from the database.

Paste Paste the clipboard contents to the currently
selected item.

Select Job Select an item in the database view in
preparation for printing or reporting.

Select All Select all entries in the database view.

Find Job… Locate a database item.
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Database (Test) View

Command Description

Edit Test Modify a Test.

Delete Delete a test from the database.

Cut Cut the currently selected test(s).

Copy Copy the currently selected tests to the
clipboard.

Paste Paste the clipboard contents to the currently
selected item.

Select Test Select a test in the database view for printing
or reporting.

Select All Select all tests in the job.

Set Operator Provide details about the operator for the
currently selected test.

Find Test Locate a database test item.
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The View Menu

The View pull-down menu allows you to hide or display the toolbar or status bar
and view.

While in database (test) view, select a test and click on the Test Information option
to open the Test Information window.
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The Test Summary Information is located on the top of the screen.

Job Name The name of the job to which this test belongs.

Customer The customer for whom the test and job have been performed.

Test Standard The standard used by the handset to perform the test.

Date The date the test was performed.

Operator The name of the operator who performed the test.

Test Instrument The type and serial number of the instrument used to perform
the test.

Frequency Range The test frequency range of the tested cable.

NVP The Nominal Velocity of Propagation value defined for the
cable on which the test was performed.

Individual tests can be viewed by clicking on a test tab to display stored test
results.  A red dot on a test tab indicates one or more tests within the tab failed. A
green dot indicates that all tests within the tab passed.
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The Options Menu

Use the Options pull-down menu to configure the program to match the hardware
and user preferences.

Command Description

Sort Sort tests in the database view.

Units Choose feet or meters as the measurement units for
both the screen display and printouts.

Serial Port Configure the serial port for your LANTEK tester.

Graphing Select graphing options.

Upload Target Designate the source of data.

Font Change the screen display font.

Language Change the language for both the screen display and
printouts.

Tester ID Locate and identify a connected tester.
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The Help Menu

This menu provides the standard windows Help support, and displays the About
dialog.

The Status Bar

The Status Bar at the bottom of the screen lists the functions that are currently
operating and indicates the number of tests residing in the currently highlighted
job.
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The Toolbar

The toolbar icons are shortcuts for many of the commands on the pulldown menus.

Tool Button Identification

Create a new
database

Upload Test

Open a database Find Tester ID

Save Set Operator

Cut Backup

Copy Select All

Paste Sort Test

Delete Find Jobs or Test

Export Help Assistant

Print Help

The Right Mouse Button

The right mouse button provides a shortcut to either display the Job or Test Edit
menu depending on the area of the window where the click is performed.
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LANTEK Reporter Help System Overview

Help Topic Menu Option

The Help Topics menu option is the primary way to gain access to the LANTEK
Reporter Help system.

To open the Help System

1. Pull down the Help menu and click the Help Topics command. The Help
Topics screen displays.

Help Topics Screen

The LANTEK Reporter Help Topics screen contains three tabs and three buttons.
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Content Tab

The Content tab displays a list of topics in the LANTEK Reporter Help system
organized by category.

Index Tab

The Index tab is similar to a traditional book index, listing keywords and phrases
alphabetically.
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Find Tab

The Find tab allows a full-text search for any word or phrase in the Help system.

Display button Opens the selected LANTEK Reporter Help item.

Print button Prints the selected item.

Cancel button Closes the LANTEK Reporter Help system.
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Using Help Screen

The Using Help screen consists of four tabs and a menu bar. The screen contains
instructions for using and customizing the LANTEK Reporter Help system. The
Web Help feature allows you to access Microsoft Product Support Online.

About LANTEK Reporter Screen

The About LANTEK Reporter screen displays the LANTEK Reporter version
number running on your computer.
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Uploading DH Tests to the PC

The LANTEK tester is capable of storing tests in individual job folders that can be
uploaded. To upload to a job folder on the PC, you must create a new job folder
or use an existing job folder before uploading the tests.

To create a new database, refer to Creating a New Database. To create a new job
name, refer to Adding a Job.

Upload procedure

1. Designate the upload location on the PC or Laptop.

Before uploading test data from the LANTEK DH, select a destination
database in the Database View.

2. From the File pull-down menu,
click on Upload From Tester.
The Upload dialog box displays.
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3. Click the desired Upload Test Type button.

4. Select a job in the Select Upload Job text box.

Note: If you want to add AutoTests from a job in the cable tester to an existing LANTEK
Reporter project with the same name, you have to select the mother project as
<upload job>, that is located one level higher. (For example, JOB 1 in the cable
tester; select <LANTEK> as upload job)

5. Select the Data Source.

• Choose Comm Port for direct connection (USB or Serial) with the tester.

• Or Data Storage Device if you have stored the test results on the compact
flash card and are using the USB flash card reader or if you have files
stored on an alternate media device on your PC (CD ROM, Zip Disk, Hard
Drive).

6. Click OK to begin the uploading process.

7. A status box will remain on screen during the uploading process and you will
have the option to cancel at any time.
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Utilizing Graph Data

The saving of graph data is optional on the LANTEK 6/7. To help resolve a
problem with a link under test, a collection of graph data can made at the time the
Autotest was performed. Once the “passed” test results have been uploaded to
LANTEK Reporter, these graphs may no longer be needed. The LANTEK
Reporter allows you to specify whether or not to include graphs with the test
result data. This activity can be selected through the Options Menu under the
Graphing command.

Save Graph Data

Select this option to save graph data, if present, when tests are uploaded from the
tester.

Enable Graphs on Detailed Reports

Select this option to enable printing of summary graphs in the detailed report. The
option, Save Graph Data, must be enabled when test data is uploaded in order for
this option to have an effect. Printing graphs will substantially increase the total
time required to print the detailed reports.
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Working with Databases

On start-up, the database that was opened last will automatically reload.

Note: The first startup of LANTEK Reporter will load an ‘empty’ database (c:\…\ IDEAL
INDUSTRIES \ LANTEK Reporter \db) from the database directory.

Creating a New Database

1. Pull down the File menu and click the New command or click  on the
toolbar.

2. You can either type the new path and database name or choose Browse and
select an existing path and then type in the database name.

Note: The name of the new database displays only in the title bar of the main
window.

3. Click OK to enter your selection.

Note: We recommend creating a new database for each new customer. When all of the
reporting has been completed, make a final database backup and move the file off
the computer to another media device (i.e. CD ROM or backup disk). This practice
will ensure the optimum performance and test data integrity.
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Opening an Existing Database

1. Pull down the File menu and select the Open command or click  on the
toolbar.

2. Use the Browse feature to locate the desired database folder and file.

3. Click OK to open the database.
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Working at the Job Level

Navigating the Job Tree

Tests are stored in folders called Jobs. For example, each floor of a building can be
listed as a separate Job. Another Job can represent the entire building or just those
tests conducted by a particular technician.

The left side of the Database View shows the hierarchy of Jobs. Clicking on a Job
folder that is preceded by a plus (+) sign reveals the Jobs it contains. This
hierarchy can be up to five levels deep.

Jobs that have attached test records are indicated by an  icon. When you click
on this icon, the test records become visible on the right side of the screen.

You may move Jobs from one folder to another by selecting and dragging them.
Selection is indicated by a highlight bar.
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Adding a Job

You must click on the left side of the main database view for the Add or Edit Job
functions to be available. You can create a new collection of tests by adding a Job
folder.

1. Select the folder that you want to add a Job to.

2. From the Edit menu, click Add Job. The Add Job dialog box displays.

3. Type in a name for the Job folder and any notes you want to add.

4. Click OK to create the new job folder.

Note: The preferred method of initiating the Add Job function is to right click the mouse
on the job list where the new job can be defined as a sub job.
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Editing a Job

To change the name of a Job folder or attach text notes to it:

1. Select a Job

2. From the Edit menu, click Edit Job. The Edit job dialog box appears.

3. Click on the Name or Note text boxes to perform the desired edits.

4. Click OK when you are finished.
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Adding or Editing Customer Details

You may want to add or modify customer details for a specific Job entry.

1. From the Edit menu, select Edit Job.

2. Click Customer. The Add Customer or Modify Customer dialog box displays.

3. Add new customer information or edit existing information. If a customer
name is supplied it will appear at the beginning of a report.
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Adding or Changing the Test Set Operator Name

You may add or change the operator name associated with a given test.

1. Open a job and position the cursor in the desired test field on the right side of
the screen. Select one or several Autotest(s).

2. Select the Edit menu. Click Customer or click . The Set Operator dialog
box displays.

4. Click on the Drop-down Menu for a list of all operators.

5. Select an operator from the drop-down list or enter a new operator name.

6. Click OK when you are finished.
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Finding a Job or Test

The Find function searches for Job Names, Cable IDs, and Tests. You can control
both the type of match and the direction of the search.

1. Before opening the Find dialog box:

• Click on a folder at the Job level on the left side of the main database
screen to find a job.

• Click on a test in the test grid on the left side of the main database screen
to find a test.

2. Select the Edit menu. Click Find Job or Find Test or click  on the
toolbar. The Find dialog box displays.

4. Enter the job name and then specify the find criteria using the Match case and
Direction buttons.

5. Click Find Next to search for the next occurrence of the text.

6. Click Cancel when you are done searching.
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Working at the Test Level

Displaying the Test Grid

1. Click on a Job folder that contains tests, as indicated by an  icon.

2. A list of test records will appear on the right side of the Database View.
This is referred to as the Test Grid.



Chapter 6
Using LANTEK REPORTER

6-34

Viewing Test Details

1. Click on a Job folder that contains tests, as indicated by an  icon.

2. Double-click on any test entry in the test grid (left side of the main database
screen) or hold down the Control key and type “V”. Depending on the type of
cable, you will see individual tabs for each test.

3. Click on the desired Test Tab to view the test results.
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GRAPH Button

The GRAPH button may or may not be enabled, depending on whether graph data
was saved during the uploading process of the test results. If it is enabled, you can
select this button to view graphs of individual test results performed.

The Graph Display

The graphical data display, depending upon the test tab that has been clicked,
provides radio buttons on the left side to select the pair and/or the test reference
site of the graphed data.

• The window displays the test result data over the plot area.

• The small popup window shows the frequency and dB value of the data point
at the cursor.
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The Graph Display has its own tool bar.

 Save
Save a graph in one of five different file formats (Chart FX
files, Chart FX templates (no data), Text file (data only),
Metafile picture, or Bitmap picture).

 Copy
Copy a chart in one of four formats (Bitmap, Metafile, Text
(data only) or OLE object) to the Windows clipboard. Data
in the clipboard can be pasted into other applications.

• Bitmaps and Metafiles can be pasted in a Word
document.

• Text data can be pasted in an Excel spreadsheet.

 Color
Change the color of various items on the graph. Click and
select a color from the drop-down dialog. Click, hold and
drag the color to the desired item on the chart.

 Zoom
Magnify an area of the graph. Click and move to the area of
the plot that is to be magnified. Click, hold and drag on the
area to be zoomed. This zoom operation can be repeated to
intensify the magnification.

 Vertical

 Horizontal

Toggle between showing and hiding the grid lines.

 Data
Show or hide the data values in a grid.

 Print Preview
Display the graph in a hard copy format prior to printing.

 Print
Open the print dialog allowing printer selection and print
options. Click OK to print the graph.
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Moving Tests Between Jobs

Tests may be selected and dragged into different Job folders.

1. Click on a test (or a range of tests) to select it.

• To select an individual test, click the first column of the preferred test.

• To select a range of tests, click the first column then hold and drag to the
last test preferred.

• To select a set of non-contiguous tests, click the first column of each test
while holding down the Control key.

2. Move the cursor to the bottom of the highlighted area. The cursor will turn
into a rectangle.

3. Click and hold the left mouse button while you drag the test(s) into a new Job
folder on the left side of the screen.

4. Release the mouse.
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Editing Tests

This function becomes available on the Edit menu when a test record is selected. It
can also be accessed by using the right mouse button.

1. Before opening the Edit menu:

• Click on a folder at the Job level at the left side of the main database
screen to find a job.

• Click on a test in the test grid on the left side of the main database screen
to find a test.

2. Select the Edit menu.

3. Click Edit Test to open the Edit Test dialog box.

4. Enter the cable ID in the text box labeled “From”. Enter the destination of the
cable in the text box labeled “To.”

5. Enter data into the From, To, and Notes text boxes.

6. Click OK.
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Sorting the Tests

The Sort function allows you to reorganize tests in the Database view. You may
Sort by Result, Cable ID, Cable Origin, Cable Destination, Cable Type, Test Type,
Date, and Time. The easiest way to sort is to click on a column title. You sort by
ascending, descending or natural order. The Sort function is available when more
than one test is selected in the grid view.

1. On the Options menu, click Sort.

2. Click the Down Arrow next to each field and choose from the sorting options
that are displayed.

3. Click OK to begin the sort.

You can sort tests according to three different values, with highest sort criteria
listed first, followed by the second, and then the least significant sort criteria.
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Finding Data

The Find function searches for Job Names, Cable IDs and Tests. The Find function
can be found on the Edit menu. It is context sensitive, and is available only when
you have selected an item in the Test grid.

You can control both the type of match and the direction of the search. For
example, if you are searching for a Test, you should have an item on the Test level
of the hierarchy selected before bringing up the Find dialog box.

1. Before opening the Edit menu:

• Click on a folder at the Job level at the left side of the main database
screen to find a job.

• Click on a test in the test grid on the left side of the main database screen
to find a test.

2. Select the Edit menu.

3. Click the Find Test command. The Find dialog box displays.

4. Enter the test name, then specify the find criteria using the Match case and
Direction buttons.

5. Click Find Next.
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Backing Up and Restoring Databases

Regular data backups to a removable storage device are recommended. You may
also restore databases to the PC from these archives.

Backing Up a Database

Following a backup, the program will compact the database and remove any
deleted records.

Click the File menu and select the Backup command or Click  on the toolbar.
The backup will be placed in the current folder.

Note: Prior to performing an uploading of test results the currently open database is
automatically backed up.

Restoring a Database

This function becomes available on the File menu only after all databases have been
closed.

1. Click the File menu.

2. If you have a database open, click Close Database and proceed to step 3. If
you don’t have a database open, proceed to step 4.

3. Click on the File menu again.

4. Select the Restore Database command. The backup file will be restored to the
current folder.
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Producing and Printing a Report

Headers and Footers Command

Headers and footers can be added to your printed report. In a printed report, lines
will separate the header and footer from the body of the report if the header or
footer contains any information.

1. From the File menu, click Headers/Footers, the Headers/Footers dialog box
displays.

2. Decide on the position for your header or footer and click the accompanying
Down Arrow.

3. From the drop-down text box, select one of the displayed options.

• If you select Text, the Text Box will open. Enter your information.

• If you select Logo, you must supply the location of the Bitmap file
(.bmp file) to be used as the logo. Type the name of the file directly into the
box titled “Logo File:” or use the Browse function to locate the file.

Note: Customer is a value that is set in the Edit Job function.

4. Click OK.
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Page Setup Command

Margins, paper instructions, and printer selection can be set in the Page Setup
dialog box. Font style and size will be set by the program to maintain a single page
per test.

1. From the File menu, click on Page Setup, the Page Setup dialog box displays.

2. Set Paper Size, Source, Orientation, and Margins.

3. Click OK.

Note: You may also need to adjust the space you allocate to the header, footer, and
margins in order to fit the report on one page.
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Print Command

Printing involves two steps: selecting the printer; and specifying what you want to
print.

1. From the File menu, click Print or click  on the toolbar. The Print dialog
box displays.

2. Select Report Type, Printer, Print Range, and the number of Copies.

3. Click Preview to display your report as it will appear in print.

4. Click OK.
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The Single Line Report Layout

The Single Line Report prints one line for each test. The tests included in the
report are determined by what item(s) are selected in the views.

• If a job is selected in the Tree view, all tests in that job are included.

• If tests have selected in the Grid view, the selected tests are reported.

To view summary test information for the selected job, check the ‘‘Show
Summary Data’‘ box.



Chapter 6
Using LANTEK REPORTER

6-46

The Brief Report Layout

The Brief Test Report prints out summary information about all subordinate tests
for each test. The tests included in the report are determined by what item(s) are
selected in the views.

• If a job is selected in the Tree view, all tests in that job are included.

• If tests have been selected in the Grid view, the selected tests are reported.

To view summary test information for the selected job, check the ‘‘Show
Summary Data’‘ box.
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The Detailed Layout

The Detailed Test Report prints out detailed subordinate test’s information for all
selected tests. The tests included in the report are determined by what item(s) are
selected in the views.

• If a job is selected in the Tree view, all tests in that job are included.

• If tests have selected in the Grid view, the selected tests are reported.

To view summary test information for the selected job, check the ‘‘Show
Summary Data’‘ box.
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Testing Twisted Pair Cables

Twisted pair wiring systems (Figure 7-1) typically employ four pairs of insulated
conductors and connectors that allow you to operate different network types on
the same cable (Table 7-1). Both unshielded (UTP) and foil shielded (STP, FTP)
cables are available.

Jacket

Insulation

Tinned Copper Stranded
or Solid Conductor
(4 Pairs)

Copper Drain Wire
(Shielded Cable only; STP)

Aluminum-Polyester Shield
(Foil Shielded Cable only; FTP)

The following diagram shows modular jack pin numbering and wiring
patterns for T568A, T568B, 10 Base-T, TP-PMD and USOC cabling
types.

Figure 7-1: Twisted Pair Cables
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Table 7-1: Twisted Pair Cable Types and Associated Networks

Cable Type Network Examples
TIA Cat 3, 5e, 6 UTP or STP and 7 STP Ethernet, Fast Ethernet, ATM, and Gigabit

Ethernet
ISO Class C, D, E and F UTP or STP Ethernet, Fast Ethernet, ATM
TP-PMD / TP-DDI FDDI or ATM on Copper
10Base-T Ethernet
Single Pair Telephone, Apple Local Talk, ISDN
Shielded Two-Pair (1,2,7,8) ATM, Fiber Channel on Copper

Shielded Twisted Pair (STP)

Testing the continuity of the shield is important and requires shielded test leads at
both the Display Handset and Remote Handset. When testing STP, be sure to
select Shielded Cable Type (STP) in the Cable Type menu.

 

Twists are maintained to within ½” 
as required per TIA Category 5e 
insulation guidelines 

Screened Category 5e Cable 
(ScTP) 

Metallic shield provides EMI 
protection 

Figure 7-2: Shield Continuity Test Connections Twisted Pair

USOC Wiring

If a USOC (Universal Service Ordering Code) or other wiring scheme is used, a
special adapter may be required for connection. Refer to Appendix D, Model
Accessories for a full list of available cable adapters.
Note: If your testing requirements include connection to something other than an RJ-45

or Tera style jack, refer to Testing with Block Adapters later in this chapter.
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Permanent Link Test Setup

ANSI, EIA, TIA, and ISO all provide two network communication circuit
specifications: permanent link and channel link. A permanent link consists of up to
90 meters of horizontal network cabling. The permanent link (shown below) is
used to certify the horizontal network cable installation before network connection
and user hookup. It excludes adapters, patchcords, and jumpers.

Display
Handset

Remote
Handset

Channel Link Adapter and 
2 Meter Patchcord

Network
Patch Panel

RJ-45
Wall Outlet

Horizontal Network Cable
(Maximum of 90 Meters)

A U T O
T E S T

NET MONITOR

WIRE MAP

TDR

LENGTH

SHIFT

750 MHz Certifier

F1 F2 F3 F4
F5 F6 F7 F8

ENTER

Escape

TALK

ANALYZE

SETUP

HELP

1 2 3

4 5 6

7 8 9

0

ABC DEF GHI

JKL MNO PQR

STU VWX YZ

SPACE

A U T O
T E S T

E S C A P E

TONE MODE

TONE

PAGE
TALK

SHIFT

Remote

HAZARD PASS FAIL ON

750 MHz Certifier

Channel Link Adapter and 
2 Meter Patchcord

Figure 7-3: Permanent Link Test Connections

Connection Cable Length Limits
Horizontal Network Cable Maximum of 90 meters

Note: Ensure that the Cable Type is set to Twisted Pair Permanent Link.
If you exceed the tester length test limits, the tester will fail the link.
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Channel Link Test Setup

A channel link includes all aspects of the cabling system. It consists of up to 90
meters of horizontal network cabling, user patchcords, jumpers, and channel
adapters at each end. The channel link (shown below) is used to certify the
network installation, including the horizontal link and user patchcords.

Display
Handset

Remote
Handset

User Patch Cord

Channel Adapter

Channel Adapter User Patch Cord

Network
Patch Panel

RJ-45
Wall Outlet

Horizontal Network Cable
(Maximum of 90 Meters)

A U T O
T E S T

NET MONITOR

WIRE MAP

TDR

LENGTH

SHIFT

750 MHz Certifier

F1 F2 F3 F4
F5 F6 F7 F8

ENTER

Escape

TALK
ANALYZE

SETUP

HELP

1 2 3

4 5 6

7 8 9

0

ABC DEF GHI

JKL MNO PQR

STU VWX YZ

SPACE

A U T O
T E S T

E S C A P E

TONE MODE
TONE

PAGE
TALK

SHIFT

Remote

HAZARD PASS FAIL ON

750 MHz Certifier

Figure 7-4: Channel Link Test Connections

Connection Cable Length Limits
Horizontal Network Cable Maximum of 90 meters
User Patchcords Combined Maximum length of 10 meters

Note: Ensure that the Cable Type is set to Twisted Pair Channel Link when testing with
channel adapters. If you exceed the tester length test limits, the tester will fail the
link.
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Wire Map Test

Wire Map testing is used to locate shorts, opens, and miswires. Test results are
displayed graphically for easy visual indication of any problems.

Note: The RH is required to perform this test.

Wire Map Errors

A failure in a Wire Map should always be the first problem corrected, since it
causes faults in other tests. One open pin can cause DC loop resistance and
attenuation tests to fail. An open may also cause a zero capacitance reading, and
will cause false readings in NEXT tests.

A wire map test will always look for and map all nine possible wires (four pairs +
shield) but will only consider wires defined as present in the selected cable type
(refer to Chapter 3, Changing a Cable Type) for pass/fail criteria. For example, a
wire that is not specified in the cable type will show on the map but will not cause
a test failure.

The Wire Map test guarantees the following minimum level of error detection
(based on four pairs of conductors, shield optional):

• Any wiring error or combination of wiring errors will indicate a wire map
failure.
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• Any combination of up to three opens, shorts, or cross-connections will be
correctly identified.

• Opens and shorts will provide an indication of the cable end that the error
occurred on (provided by Length screen results in Autotest.).

• Split pairs will be identified based on specific patterns of inconsistent NEXT
(Near-End Crosstalk).

Troubleshooting Wiremap Problems

Problem: One or more open pins

Probable Causes Connector-to-wire punch down not mated
Defective jack or plug.
Broken wire(s).

Other Tests Affected Test Possible Result
DC Resistance Fail.
Attenuation Fail.
NEXT Some false measurements.
Mutual Capacitance 0 reading possible.
Length May be low if the open is near the

Display Handset.

Problem: Shorted pins

Probable Causes Conductors making contact at a connector.
Jack or plug has pin or circuit defect.
Cable damaged.

Other Tests Affected Test Possible Result
DC Resistance Low or zero.
Attenuation Fail.
NEXT Some false measurements.
Capacitance Over limit.
Length Reduced or shorted pairs.
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Problem: Miswired pins

Probable Causes Conductors reversed at a connector.

Other Tests Affected Test Possible Result
Usually none Infrequently, one or more tests may

fail.

Wire Length Test

This test measures the length of each wire pair to make sure that the recommended
limits for the particular cable type are not exceeded. Depending on the units
selected in the Setup menu, length is reported in either feet or meters. See Chapter
3, Setup information.

Note: The RH is not required to perform this test.
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Length and NVP

Measuring the length of the cable requires that you know the Nominal Velocity of
Propagation (NVP) of the cable. Refer to the specification or the manufacturer of
the cable you are testing for the cable NVP. If the wire specification is not
available, use a known length of good cable (50 to 100 feet) and adjust the NVP
until the tester displays the known cable length.

Wire Length Errors

Lengths may differ slightly between pairs in the same cable, due to minor NVP
differences between the pairs and physical length differences due to twisting
patterns. When electrically measured cable length varies too much from actual
length, a problem exists.

Troubleshooting Wire Length Problems

Problem: Length between a pair of the same cables varies by more
than 10%.

Probable Causes Incorrect NVP.
Excessive cable length.
Installed matched terminator not functioning correctly.
Cable insulation damage to longer pairs.
Break or short in a pair.
Elevated capacitance on a pair.

Other Tests Affected Test Possible Result
DC Loop Resistance May be slightly high or fail.
Attenuation May be slightly high or fail.
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DC Resistance Test

This test measures the loop resistance of each pair of wires. The instrument tests
to make sure total loop resistance does not exceed recommended limits. Results
are displayed with resistance in ohms for each pair, and a comparison limit for the
cable type.

Note: The RH is required to perform this test.
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DC Resistance Errors

All four pairs of a network link should have approximately the same resistance.
Pair resistance that exceeds the limit is indicated as a failure.  The maximum limits
in the default tables are based on the maximum length limit of the link or cable
segment.

Troubleshooting DC Resistance Problems

Problem: Excessive Resistance

Probable Causes Mismatched cable types.
Poor punch block connection.
Poor RJ-45 termination connections.
Wire pair has a tap (never done).
Cable damage.
Shorted cable.

Other Tests Affected Test Possible Result
Wire Map May fail.
Attenuation May fail.
NEXT May have false readings.
Capacitance May fail.

Problem: One wire pair has a very high DC loop resistance, others
are normal.

Probable Causes Poor connection points.
Cable damage.
Connector blades not fully piercing wire insulation.
Worn Connector

Other Tests Affected Test Possible Result
Wire Map May fail.
Attenuation May fail.
NEXT May have false readings.
Capacitance May fail.
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NEXT, ELFEXT, and Power Sum Tests

The NEXT (Near End Crosstalk) and ELFEXT (Equal Level Far-End Crosstalk)
tests measure crosstalk at the near and far ends of the cable in one Autotest. High
levels of crosstalk can cause excessive retransmissions, data corruption, and other
problems that slow the network system.

NEXT Test Screens

Note: The RH is required to perform these tests.
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ELFEXT Test Screens

NEXT, FEXT, and ELFEXT

The NEXT test measures cross-talk from a transmitting pair to an adjacent pair in
the same cable sheath. NEXT is measured at the both the DH and the RH.

1

2

3

6

4

5

7

8

2

1

3

6

4

5

7

8

Effect of
Adjacent Pair



Chapter 7
Cable Testing Fundamentals

7-14

The FEXT test is similar to the NEXT test except that the traffic is generated at
the RH and crosstalk is measured at the DH.

• NEXT measurements are made at each end of the cable for all pair
combinations (pair 1-2 vs. 3-6, etc.), yielding a total of twelve measurements.

• ELFEXT measurements are made with the DH and RH for all possible pair
combinations (1-2 vs. 3-6, 3-6 vs. 1-2, 1-2 etc.) at both ends yielding a total
of twenty-four measurements.

Power Sum NEXT and Power Sum ELFEXT

Power Sum tests measure the crosstalk effects of three transmitting pairs on the
fourth pair in the same cable sheath.
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During the Power Sum NEXT test, six measurements are made at each end of the
cable and combined (pairs 1-2, 3-6, and 4-5 vs. pair 7-8, etc.) for a total of eight
measurements.
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During the Power Sum ELFEXT test, twelve measurements are made at the DH
side of the cable and combined (pairs 1-2, 3-6, 4-5 vs. pair 7-8, etc.) for a total of
four measurements.

Note: Power Sum NEXT measurements will generally read 2 - 3 dB lower in value
(higher crosstalk) than conventional NEXT.
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NEXT and ELFEXT Errors

Crosstalk is usually caused by poor connector termination on the ends of the cable.
The smaller the number, the greater the crosstalk.

Troubleshooting NEXT and ELFEXT Problems

Problem: Low dB test readings

Probable Causes Installed cable or patch cable not correctly rated.
Defective, poor quality cable or too many connectors.
Poor quality installation at the connection points.
Too much insulation has been stripped from the wires at
termination.
A pair of wires has been untwisted too much at termination.
Split-pairs.
Poor quality connectors or connectors not rated to desired
category.
Delay skew (ELFEXT).

Other Tests Affected Test Possible Result
Return Loss May be over limit.
NEXT May show same symptoms.
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Attenuation Test

This test measures the overall signal strength loss in the cable and verifies that it is
within acceptable limits. Low attenuation is essential for error-free transmission.
Attenuation is measured by injecting a signal of known amplitude at the Remote
Handset and reading the amplitude at the Display Handset.

Note: The RH is required to perform this test.
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Attenuation Errors

Attenuation causes a loss of signal strength over a cable. The loss increases with
cable length, signal frequency, and temperature. Attenuation testing can be used to
find problems in the cable, connectors, or connecting hardware. The larger the
number, the greater the attenuation.

Troubleshooting Attenuation Problems

Problem: High Attenuation Reading

Probable Causes Poor connector termination points.
Excessive cable length.
Incorrect or poor quality adapter cable.
Incorrect cable.

Other Tests Affected Test Possible Result
DC Loop Resistance May be high.
Capacitance May be high.
Length May be over limit.
NEXT May be low on pair combinations.
Average Impedance May be low.
Return Loss May be over limit.
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Return Loss Test

This test measures the ratio of reflected to transmitted signal strength. Good
quality cable runs will have little reflected signal, indicating good impedance
matches in the run’s various components.

Note: The RH is required to perform this test.
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Return Loss Errors

Like attenuation, excessive return loss reduces signal strength at the receive end. It
also indicates a mismatched impedance at some point along the cable run. A value
of 20 dB or greater indicates a good twisted pair cable. A value of 10 dB or less is
severe, and causes a large reflection of signal back to the source.

Troubleshooting Return Loss Problems

Problem: Excessive Return Loss (Value of 10 dB or less)

Probable Causes Open, shorted, or damaged cable.
Installed cable, cable segments, or patch cord have improper
characteristics.
Damaged or worn cable or connectors.
Poor punch-down.
Factory splice in cable.

Other Tests Affected Test Possible Result
Attenuation May be high.
Capacitance and
Average Impedance Could be affected if the impedance 

mismatch is caused by cable 
damage.

DC Loop Resistance May be high if due to a poor
punch-down.
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Impedance Test

Average impedance is derived from electrical delay and capacitance measurements.
The results of this test are expressed in ohms. Average impedance testing can help
identify physical damage to the cable, connector defects, or cable segments with
incorrect characteristic impedance.

This test uses capacitive measurements; therefore, it is necessary to specify the
correct cable type in order to accurately perform the test.

Note: If a CAT 3 cable is selected (specified as the cable type where PVC is used in the
cable insulation) but a CAT 5 cable (where Teflon is used as the cable insulation)
is actually used, the average impedance will be calculated incorrectly. To avoid this
problem, be sure to specify the correct cable type.

Note: The RH is not required to perform this test.
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Impedance Errors

Impedance errors cause signal reflection and strength reduction. Average
impedance of each pair should be equal to the LAN system impedance of 100, 120,
or 150 Ω, plus or minus 15 Ω.

Troubleshooting Impedance Problems

Problem: High Impedance Readings

Probable Causes Compression, stretching, or excessive bending damage to
the cable.
Defective connectors.
Insulation damage at a connector.
Ground loops created between cable shielding (if used) and
equipment grounding (via RS-232 cable to computer, or
auxiliary power).
Improperly chosen cables or patch cords.
Moisture in the cable.

Other Tests Affected Test Possible Result
Length Affected pairs will appear longer.
Average Impedance Change in average impedance is

inversely proportional to change in
capacitance.
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Delay and Skew Test

This test measures the period of time for a test signal applied to one end of a cable
run to reach the other end. Skew indicates the difference between the measured
time delay for that pair and the pair with the lowest value (displayed as 0.0 ns).
Delay and Skew limits are set according to the currently selected cable type.
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Delay and Skew Errors

Delay and skew measurements will usually differ slightly between pairs in the same
cable. A substantial difference indicates a cable installation problem or a pair
defect.

Troubleshooting Delay and Skew Problems

Problem: Excessive Differences Between Measurements

Probable Causes Cables which use different materials for insulating the four
pairs of wires.
A break or short in the pair.
Excessive cable length.
Cable installation problems.
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Capacitance Test

This test measures the mutual capacitance between the two conductors of each
wire pair to verify that installation has not affected the capacitance for the
particular cable type.

• Bulk capacitance measurements are displayed in nanofarad (nF) in the Analyze
Capacitance test.

• Autotest measures the bulk capacitance in picofarads (pF) per foot or meter.

Note: The RH is not required to perform this test.
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Capacitance Errors

The larger the capacitance, the higher the error rate. Small changes in the
capacitance measurements are normal due to the handling of the cable during
shipping and installation. The addition of connectors and patch cables will also
affect capacitance values.

Troubleshooting Capacitance Problems

Problem: Capacitance Exceeds the Maximum Limit

Probable Causes Compression, stretching, or excessive bending damage to
the cable.
Defective connectors.
Insulation damage at a connector.
Ground loops created between cable shielding (if used) and
equipment grounding (via RS-232 cable to computer, or
auxiliary power).
Improperly chosen cables or patch cords.
Moisture in the cable.
Poor connections at punch downs and wall plates

Other Tests Affected Test Possible Result
Length Affected pairs will appear longer.
Average Impedance Change in average impedance is

inversely proportional to change in
capacitance.
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ACR and Power Sum ACR Test

The ACR (Attenuation-to-Crosstalk Ratio) test performs a mathematical
comparison (difference calculation) between the results of the Attenuation and
NEXT tests. The difference reading between each pair gives an indication of how
problem-free the cable pair will be for transmissions.

The ACR measurements are calculated pair-to-pair.

Note: The RH is required to perform these tests.
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The Power Sum ACR measurements are calculated by summing the NEXT
between a selected pair and the other three pairs in the same cable sheath.

ACR and Power Sum ACR Errors

A large difference reading is desirable, since it indicates a strong signal and little
noise interference.

Troubleshooting ACR and Power Sum ACR Problems

Refer to the NEXT and Attenuation troubleshooting suggestions in this chapter.
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Headroom Test

The Headroom measurement is a mathematical analysis of the data already existing
from previous tests.  The calculated value is the sum of the Power Sum ACR test
(Power Sum ACR of the worst pair after the attenuation for that pair has been
normalized to 100 meters or 328 feet) and the additional margin between the worst
case PS NEXT and the limit for PS NEXT.

Headroom provides a simplified means of reporting the margin available in a single
cable run which will support an application with error-free performance. It also
gives an indication of additional margin which may be achieved through the
utilization of “enhanced” cable and connectors and careful installation practices.

Note: The RH is required to perform this test.
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Headroom Errors

The Headroom number, reported in dB, characterizes the worst-case margin found
in a single cable run.  A large number is desirable, since it indicates a strong signal
and little noise interference. The pass/fail limit for Headroom is the same as Power
Sum ACR.

Testing and Troubleshooting 10BASE-T Cabling

10BASE-T Ethernet systems use twisted pair cabling for transmission of network
data frames. Both the cable and connecting hardware must meet minimum
standards as specified in the IEEE 802.3 standard. The default settings for
10BASE-T network links in the LANTEK tester reflect these standards.

10BASE-T systems use the 1 and 2 pins for transmit and the 3 and 6 pins for
receive, as shown in Figure 7-5. The instrument passes or fails the Wire Map based
on this pin configuration. If your system does not use the IEEE 802.3 wiring
standard, a custom adapter is required to align nonstandard transmit and receive
pairs.

Figure 7-5: 10BASE-T Connector

Note: Other pairs may be wired, but 10BASE-T uses only the pairs shown.
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Testing and Troubleshooting with Block Adapters

Testing with 110 and 210 Connecting Block Adapters

At times, it is necessary to test directly from a 110 or 210 connecting block to
either a patch panel or office outlet. IDEAL INDUSTRIES Category 6 adapters
allow testing up to 250 MHz or to the manufacturer’s specified limit.

Use a patchcord with a RJ45 plug on one end and the appropriate 110 or 210 plug
on the other end. The RJ45 end of this patchcord is usually connected to the
Display Handset. However, if required, it can be connected to the Remote
Handset. Connect the other handset using one of the patchcords supplied with
your tester.

Note: Observe the Wire Map results on the first test carefully. If the Wire Map fails, it
may indicate a reversal between T568A and T568B wiring standards. Try replacing
the adapter patchcord with the opposite patchcord and the link should map
correctly.



A-1

Appendix A
Safety Precautions

Contents

• Handle Battery Packs With Care

• Statement of Liability

• Environmental Statement

• Important User Information

Handle Battery Packs With Care

DO NOT dispose of NiMH battery packs in a fire or with regular trash. NiMH
batteries may explode if exposed to open flame, create hazardous waste, and
contaminate ground water sources if disposed of in land fills.

CAUTION - All Nickel-Metal Hydride (NiMH) battery packs, regardless of their
indicated charge state, are capable of producing electrical currents sufficient to
cause personal injury and/or property damage.

IDEAL INDUSTRIES has tried to provide the maximum protection possible by
installing an automatic reset fuse in every battery pack to help stop high current
discharges as quickly as possible. However, this fuse may not completely protect
against a momentary arc, which can result if the battery pack’s electrical contacts
are shorted. The following battery pack handling precautions must be closely
followed to avoid risk of injury.

• When a battery pack is not installed in the handset or the charger, it should be
kept in a clean, dry, non-conductive package.

• Keep conductive materials away from the battery contacts at all times.
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• Keep the contact sides of the battery packs away from each other at all times.

• Batteries are normally charged while in the handsets or when using the optional
Dual Bay Battery Charger. Charging with other chargers or in any other
manner may cause the battery packs to explode.

• Always install, remove, store, and charge the battery packs in a non-explosive
atmosphere.

• Use and store battery packs in locations that do not exceed 122 degrees
Fahrenheit (50 degrees Celsius).

• Do not allow children or persons unfamiliar with the precautionary instructions
in this manual to handle or recharge the battery packs.

• Leave the sealed battery pack case intact. There are no user-serviceable parts
inside the case and the batteries in the case are not replaceable.

Statement of Liability

IDEAL INDUSTRIES does NOT assume any liability for death, injury or damage
to equipment or property resulting from the use of this charger in a manner
inconsistent with the use for which it was intended. IDEAL INDUSTRIES will not
be liable for consequences that may result from tampering with the battery packs
or charger or consequences resulting from their use thereafter.

Environmental Statement

If you have any questions concerning these precautions, the operating instructions,
or any other concerns about the safe use and disposal of the LANTEK battery
packs, please contact an IDEAL INDUSTRIES representative at one of the offices
listed in Appendix B of this manual, Customer Service and Warranty.
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Important User Information

Please read this information before proceeding with any cable testing/certification
using the LANTEK testers.

All cable parameter default settings preprogrammed in the LANTEK testers are
based on generic standards, proposed industry recommendations for cables and
network links, the latest technical information available from International LAN
cabling standards committees, the LAN industry, and IDEAL INDUSTRIES’s
own experience and testing. However, the default settings in the tester may not
yield the desired certification / test results in every given instance because each
network is a custom installation designed to suit the requirements of the users. It is
therefore imperative that specific network parameter limits be obtained from the
network designer(s) and employed during certification and testing.

Refer to Chapter 3 for information and instructions on how to select the correct
cable type, change testing methods, and customize the cable’s parameters for
certification and testing. Chapter 4, Table 4-1 provides a complete list of cable
topologies supported.
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Customer Service

Technical Assistance

For technical assistance or service questions in the U.S.A. and Canada, call IDEAL
INDUSTRIES at 1-800-854-2708 or 858-279-2200.

Service in the USA

Your LANTEK tester may require annual calibration to meet accuracy
specifications. Before returning a unit for calibration or service, call IDEAL
INDUSTRIES Technical Support at 1-800-854-2708 or 858-279-2200.

If cleaning is required, use a soft cloth and mild cleaner suitable for plastic. Do not
immerse the tester in water.

When returning a unit for service or calibration:

1. Customer name, company, address, telephone number, proof of purchase (for
warranty repairs), and a description of the service are required.

2. Pack in a soft carrying case, hard-sided carrying case, or wrap the instrument
in heavy paper or plastic.

3. Use a strong shipping container. A double-walled carton of 250-pound test
material is recommended.
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4. Use a layer of shock-absorbing material 70 to 100 mm (3 to 4 inches) thick
around all sides of the instrument to provide firm cushioning and to prevent the
unit from moving inside the container.

5. Seal the shipping container securely.

6. Ship prepaid to:

IDEAL INDUSTRIES Corporation
9145 Balboa Avenue
San Diego, CA  92123
ATTN: Instrument Repair/Service

Return shipping to the customer within the domestic U.S.A. will be paid by
IDEAL INDUSTRIES Corporation.

Service Outside the USA

For technical assistance or service questions outside the U.S.A. and Canada, call
your local distributor.

IDEAL INDUSTRIES recommends annual calibration of the LANTEK testers to
ensure that it continually meets its accuracy specifications. Before returning a unit
for calibration or service outside the U.S.A., contact your local distributor or one
of the IDEAL INDUSTRIES Corporation offices listed below. If your local
distributor does not have a service facility, they will provide assistance in returning
the tester to an authorized IDEAL INDUSTRIES service facility.

If cleaning is required, use a soft cloth and mild cleaner suitable for plastic. Do not
immerse the tester in water.

Americas

IDEAL INDUSTRIES Corporation
9145 Balboa Avenue
San Diego, CA 92123
Tel: 800-854-2708
Fax: 858-278-5141
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Europe (Germany, France, Italy, Spain, Portugal, Switzerland,
Austria, And Eastern Europe, Africa and MEA)

IDEAL INDUSTRIES GmbH
Gutenbergstrasse 10
Germany - 85737 Ismaning,
Tel: 49 89 99686-0
Fax: 49 89 99686-111

United Kingdom (Netherlands, Belgium, Luxembourg, Sweden,
Norway, Finland, Denmark, Iceland)

IDEAL INDUSTRIES (UK) Ltd.
225 Europa Boulevard, Gemini Business Park
Warrington, Cheshire WA5 7TN
United Kingdom
Tel: +44 1925 444444
Fax: +44 1925 445501

Australia

IDEAL INDUSTRIES (AUST) PTY. LIMITED
27 Keene Street
Baulkham Hills, NWS 2153 Australia
Tel: +61 2 9686 6923
Fax: +61 2 9686 2364
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World Wide Web Services

IDEAL INDUSTRIES provides a World Wide Web (WWW) site for LAN cable
test products that allows you to use a PC and modem to obtain the latest
information on cable test application notes or firmware version upgrades. A
question and answer forum allows you to share information with other users and
submit questions to IDEAL INDUSTRIES product managers.

You can download the latest firmware upgrades for your LANTEK tester using a
PC computer. Upgrade files are available on the World Wide Web at:

http://www.idealindustries.com
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Electrical Performance Specifications

A number of parameters, comparisons, and definitions for category 3, 5, 5e & 6
and ISO Class C, D, E and F cables are presented in this section.

Topics include tables and graphs that define and compare:

• Level I, II, and III accuracy levels

• Which tests are required

• Worst allowable pair-to-pair measured performance levels

• Permanent and channel link test limits
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Attenuation

Measures the overall signal strength loss in the cable. Attenuation (worst pair-to-
pair) @ 20 degrees Celsius.

ANSI/EAI/TIA

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 3.20 4.20 2.10 2.50 2.10 2.20 1.88 2.15
4.00 6.10 7.30 4.00 4.50 4.00 4.50 3.53 4.02
8.00 8.80 10.20 5.70 6.30 5.70 6.30  -  -
10.00 10.00 11.50 6.30 7.00 6.30 7.10  -  -
16.00 13.20 14.90 8.20 9.20 8.20 9.10 7.06 8.04
20.00 9.20 10.30 9.20 10.20 7.93 9.03
25.00 10.30 11.40 10.30 11.40 8.89 10.12
31.25 11.50 12.80 11.50 12.90 9.94 11.33
62.50 16.70 18.50 16.70 18.60 14.34 16.38
100.00 21.60 24.00 21.60 24.00 18.56 21.26
200.00 27.21 31.47
250.00 30.86 35.87

Category 3
ANSI/TIA/EIA568/TSB67

Category 5
ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568

Category 5e Category 6 (Draft 9)
ANSI/TIA/EIA568/TSB67/95

EINBETTENEINBETTENISO/AS/NZS

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 3.10 4.20 2.10 2.50 1.90 2.20 1.90 2.20
4.00 5.80 7.30 4.10 4.50 3.80 4.40 35.00 4.20
8.00 8.90 10.50 5.50 6.50 5.80 6.70 5.00 5.80
10.00 9.60 11.50 6.10 7.00 6.10 7.00 5.60 6.50
16.00 12.60 14.90 7.80 8.90 7.70 8.90 7.10 8.30
20.00 8.70 10.30 8.70 10.00 7.90 9.30
25.00 10.00 11.50 10.30 11.80 8.90 10.40
31.25 11.00 12.80 11.00 12.60 10.00 11.70
62.50 16.00 18.50 15.90 18.30 14.40 16.90
100.00 20.60 24.00 20.60 23.60 18.50 21.70
155.52 23.60 27.60
250.00 30.70 36.00

ISO Class-D
 Proposed

ISO Class-EAS/NZS 3080ISO Class-C
ISO Class-D 11801

EINBETTENEINBETTEN
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NEXT

Measures crosstalk from a transmitting pair to an adjacent pair in the same cable
sheath. NEXT (worst pair-to-pair).

ANSI/EAI/TIA

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 40.10 39.10 61.30 60.30 60.00 60.00 60.00 60.00
4.00 30.70 29.30 51.80 50.60 54.80 53.60 60.00 60.00
8.00 25.90 24.30 47.10 45.60 50.00 48.60  -  -
10.00 24.30 22.70 45.50 44.00 48.50 47.00  -  -
16.00 21.00 19.30 42.30 40.60 45.20 43.60 54.60 53.20
20.00 40.70 39.00 43.70 42.00 53.00 51.60
25.00 39.10 37.40 42.10 40.40 51.50 50.00
31.25 37.60 35.70 40.60 38.70 50.00 48.50
62.50 32.70 30.60 35.70 33.60 45.20 43.40
100.00 29.30 27.10 32.30 30.10 41.80 39.90
200.00 36.90 34.80
250.00 35.30 33.10

Category 3 Category 5 Category 5e
ANSI/TIA/EIA568/TSB67 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568

Category 6 (Draft 9)

EINBETTEN

EINBETTENISO/AS/NZS

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 40.10 39.10 54.00 54.00 61.20 60.30 72.70 72.70
4.00 30.70 29.30 45.00 45.00 51.80 50.60 63.00 63.10
8.00 25.90 24.30 41.00 41.00 47.10 45.60 58.20 58.20
10.00 24.30 22.70 39.00 39.00 45.50 44.00 56.60 56.60
16.00 21.00 19.30 36.00 36.00 42.30 40.60 53.20 53.20
20.00 35.00 35.00 40.70 39.00 51.60 51.60
25.00 33.60 33.60 39.10 37.40 50.00 50.00
31.25 32.00 32.00 37.60 35.70 48.40 48.40
62.50 27.00 27.00 32.70 30.60 43.40 43.40
100.00 24.00 24.00 29.30 27.10 39.90 39.90
155.52 36.70 36.70
250.00 33.10 33.10

ISO Class-C
Proposed

ISO Class-D ISO Class-E
ISO Class-D 11801  

AS/NZS 3080
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Power Sum NEXT

Measures the crosstalk effects of three transmitting pairs on the fourth pair in the
same sheath.

ANSI/TIA/EIA

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 57.00 57.00 62.00 62.00
2.00  -  -  -  -
3.00  -  -  -  -
4.00 52.00 50.90 61.80 60.50
8.00 47.10 45.70  -  -
10.00 45.60 44.10  -  -
16.00 42.20 40.60 52.20 50.60
20.00 40.70 39.00 50.70 49.00
25.00 39.10 37.30 49.10 47.30
31.25 37.50 35.70 47.60 45.80
62.50 32.60 30.60 42.70 40.60
100.00 29.30 27.10 39.30 37.10
200.00 34.30 31.90
250.00 32.70 30.20

ANSI/TIA/EIA568/TSB67 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568
Category 3 Category 5 Category 5e Category 6 (Draft 9)

EINBETTEN
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ISO

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 58.20 57.30 70.30 70.30
2.00 - -
3.00 - -
4.00 48.20 47.60 60.50 60.50
8.00 44.00 42.50 55.60 55.60
10.00 42.50 41.00 54.00 54.00
16.00 39.30 37.60 50.60 50.60
20.00 37.70 36.00 49.00 49.00
25.00 36.00 34.50 47.30 47.30
31.25 34.60 32.70 45.70 45.70
62.50 39.70 27.60 40.60 40.60
100.00 26.30 24.10 37.10 37.10
125.00 35.40 35.40
155.52 33.80 33.80
175.00 32.90 32.90
200.00 31.90 31.90
250.00 30.20 30.20

ISO Class-D 11801  Proposed
ISO Class-C AS/NZS 3080 ISO Class-D ISO Class-E
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EINBETTENEINBETTENEINBETTENReturn Loss

Return Loss is the ratio of reflected to transmitted signal. Return Loss (worst pair-
to-pair).

ANSI/TIA/EIA

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 15.00 15.00 15.00 15.00 17.00 17.00 19.10 19.00
4.00 15.00 15.00 15.00 15.00 17.00 17.00 21.00 19.00
8.00 15.00 15.00 15.00 15.00 17.00 17.00  -  -
10.00 15.00 15.00 15.00 15.00 17.00 17.00  -  -
16.00 15.00 15.00 15.00 15.00 17.00 17.00 20.00 18.00
20.00 15.00 15.00 17.00 17.00 19.50 17.50
25.00 14.30 14.00 16.32 16.03 19.00 17.00
31.25 13.60 13.10 15.64 15.06 18.50 16.50
62.50 11.50 10.10 13.54 12.05 16.10 14.10
100.00 10.10 8.00 12.11 10.01 14.00 12.00
155.52 11.00 9.00
250.00 10.00 8.00

Category 3 Category 5 Category 5e Category 6 (Draft 9)
ANSI/TIA/EIA568/TSB67 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568

ISO/AS/NZS

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 15.00 15.00 17.00 17.00 15.00 15.00 19.00 19.00
4.00 15.00 15.00 17.00 17.00 15.00 15.00 19.00 19.00
8.00 15.00 15.00 17.00 17.00 15.00 15.00 19.00 19.00
10.00 15.00 15.00 17.00 17.00 15.00 15.00 19.00 19.00
16.00 15.00 15.00 17.00 17.00 15.00 15.00 19.00 19.00
20.00 17.00 17.00 15.00 15.00 19.00 19.00
25.00 16.30 16.00 14.30 14.00 18.30 18.00
31.25 15.60 15.10 13.60 13.10 17.60 17.10
62.50 13.50 12.10 11.50 10.10 15.50 14.10
100.00 12.10 10.00 10.10 8.00 14.10 12.00
155.52 12.80 10.10
250.00 11.30 8.00

Proposed
ISO Class-C ISO Class-D ISO Class-E

 ISO Class-D 11801
AS/NZS 3080

EINBETTEN

Note: Return Loss applies only to TSB95.EINBETTEN
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ACR

Attenuation-to-Crosstalk Ratio is the difference between results of Attenuation
and NEXT. ACR (worst pair-to-pair).

ANSI/TIA/EIA

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 36.90 34.90 59.20 57.80 57.90 57.80 71.50 70.50
4.00 24.60 22.00 47.80 46.10 50.80 49.10 60.40 59.10
8.00 17.10 14.10 41.40 39.30 44.30 42.30 54.20 52.50
10.00 14.30 11.20 39.20 37.00 42.20 39.90 52.10 50.30
16.00 7.80 4.40 34.10 31.40 37.00 34.50 47.30 45.20
20.00 31.50 28.70 34.50 31.80 44.80 42.70
25.00 28.80 26.00 31.80 29.00 42.30 40.00
31.25 26.10 22.90 29.10 25.90 39.60 37.10
62.50 16.00 12.10 19.00 15.10 30.20 27.10
100.00 7.70 3.10 10.70 6.10 22.60 19.00
155.52 14.30 10.00
250.00 3.50 -

Category 3 Category 5 Category 5e Category 6 (Draft 9)
ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568ANSI/TIA/EIA568/TSB67 ANSI/TIA/EIA568/TSB67/95

ISO/AS/NZS

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 37.00 34.90 51.50 51.30 59.30 58.10 70.80 70.40
4.00 24.90 22.00 40.20 39.80 48.00 46.20 59.50 58.90
8.00 17.00 13.80 34.10 33.90 41.30 38.90 53.20 52.30
10.00 14.70 11.20 31.50 30.90 39.40 37.00 51.00 50.00
16.00 8.40 4.40 26.60 25.90 34.60 31.70 46.10 44.90
20.00 24.50 23.70 32.00 29.00 43.70 42.30
25.00 21.90 21.10 28.80 25.60 41.10 39.60
31.25 18.90 17.90 26.60 23.10 38.40 36.70
62.50 8.60 7.20 16.80 12.30 29.00 26.50
100.00 4.00 4.00 8.70 3.50 21.40 18.20
155.52 13.10 9.00
250.00 2.40 -

ISO Class-D
ISO Class-D 11801 Proposed

ISO Class-C AS/NZS 3080 ISO Class-E
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EINBETTENEINBETTENEINBETTENEINBETTENPower Sum
ACR (ANSI/TIA/EIA)

ANSI/TIA/EIA

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 54.90 54.80 71.20 70.30
2.00 - -
3.00 - -
4.00 48.00 46.40 61.80 60.50
8.00 41.40 39.40 57.00 55.60
10.00 39.30 37.00 55.50 54.00
16.00 34.00 31.50 52.20 50.60
20.00 31.50 28.80 50.70 49.00
25.00 28.80 25.90 49.10 47.30
31.25 26.00 22.80 47.50 45.70
62.50 15.90 12.00 42.70 40.60
100.00 7.70 3.10 39.30 37.10
125.00 37.70 35.40
155.52 36.10 33.80
175.00 35.30 32.90
200.00 34.30 31.90
250.00 32.70 30.20

Category 3 Category 5 Category 5e Category 6 (Draft 9)
ANSI/TIA/EIA568/TSB67 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568

EINBETTEN
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ISO

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 56.10 54.80 68.40 68.10
2.00 - -
3.00 - -
4.00 44.70 43.10 57.00 56.40
8.00 38.50 36.00 50.60 49.70
10.00 36.40 34.00 48.40 47.50
16.00 31.50 28.70 43.50 42.30
20.00 29.00 25.70 41.00 39.70
25.00 26.00 23.00 38.40 36.90
31.25 23.60 19.90 35.70 34.00
62.50 13.70 9.10 26.20 23.70
100.00 5.70 0.10 18.60 15.40
125.00 14.50 10.90
155.52 10.20 6.10
175.00 7.70 3.40
200.00 4.80 0.10
250.00 - -

ISO Class-D 11801  Proposed
ISO Class-C AS/NZS 3080 ISO Class-D ISO Class-E

EINBETTENEINBETTEN
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EINBETTENELFEXT

The same measurement as NEXT except the crosstalk is measured from the RH
and sent to DH. ELFEXT (worst pair-to-pair).

ANSI/TIA/EIA

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 59.60 57.00 58.00 57.40 64.20 63.30
4.00 47.50 45.00 48.00 45.30 52.10 51.20
8.00 41.50 38.90 41.90 39.30  -  -
10.00 39.60 37.00 40.00 37.40  -  -
16.00 35.50 32.90 35.90 33.30 40.10 39.20
20.00 33.60 31.00 34.00 31.40 38.10 37.20
25.00 31.60 29.00 32.00 29.40 36.20 35.30
31.25 29.70 27.10 30.10 27.50 34.40 33.40
62.50 23.70 21.10 24.10 21.50 28.30 27.40
100.00 19.60 17.00 20.00 17.40 24.20 23.30
200.00 18.20 17.20
250.00 16.20 15.30

Category 3 Category 5 Category 5e Category 6 (Draft 9)
ANSI/TIA/EIA568/TSB67 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568

ISO/AS/NZS

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 59.60 57.00 64.20 63.20
4.00 47.60 45.00 52.10 51.20
8.00 42.00 39.00 46.10 45.20
10.00 39.60 37.00 44.20 43.20
16.00 35.50 32.90 40.10 39.10
20.00 33.60 31.00 38.10 37.20
25.00 31.00 29.00 36.20 35.30
31.25 29.70 27.10 34.30 33.30
62.50 23.70 21.10 28.20 27.30
100.00 19.60 17.00 24.20 23.20
155.52 20.30 19.40
250.00 16.20 15.30

 Proposed
ISO Class-D ISO Class-EISO Class-C AS/NZS 3080

ISO Class-D 11801

EINBETTENNote: ELFEXT applies only to TSB95.
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EINBETTENPower Sum ELFEXT (ANSI/TIA/EIA)

ANSI/TIA/EIA

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 54.90 54.80 61.20 60.30
2.00  -  -  -  -
3.00  -  -  -  -
4.00 48.00 46.40 49.10 48.20
8.00 41.40 39.40  -  -
10.00 39.30 37.00  -  -
16.00 34.00 31.50 37.10 36.20
20.00 31.50 28.80 35.10 34.20
25.00 28.80 25.90 33.20 32.30
31.25 26.00 22.80 31.40 30.40
62.50 15.90 12.00 25.30 24.40
100.00 7.70 3.10 21.20 20.30
200.00 15.20 14.20
250.00 13.20 12.30

ANSI/TIA/EIA568/TSB67 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568/TSB67/95 ANSI/TIA/EIA568
Category 3 Category 5 Category 5e Category 6 (Draft 9)

ISO

Frequency
(MHz/dB) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.00 57.00 54.40 61.20 60.20
2.00 - -
3.00 - -
4.00 45.00 42.40 49.10 48.20
8.00 39.00 36.00 43.10 42.20
10.00 37.00 34.40 41.20 40.20
16.00 32.90 30.30 37.10 36.10
20.00 31.00 28.40 35.10 34.20
25.00 29.00 26.50 33.20 32.30
31.25 27.10 24.50 31.30 30.30
62.50 21.10 18.50 25.20 24.30
100.00 17.00 14.40 21.20 20.20
125.00 19.20 18.30
155.52 17.30 16.40
175.00 16.30 15.40
200.00 15.10 14.50
250.00 13.20 12.30

ISO Class-D 11801  Proposed
ISO Class-C AS/NZS 3080 ISO Class-D ISO Class-E
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ISO Class F (Category 7)

Measurement Limits in dB

Freq Attenuation NEXT ACR
Power 
Sum ACR

( MHz ) Permanent Channel Permanent Channel Permanent Permanent

1.0 4.0 4.0 65.0 65.0 61.0 58.0
4.0 4.0 4.1 65.0 65.0 61.0 58.0

10.0 5.4 6.4 65.0 65.0 59.6 56.6
16.0 6.8 8.1 65.0 65.0 58.2 55.2
100.0 17.5 20.8 65.0 62.9 47.5 44.5
250.0 28.4 33.8 60.4 56.9 32.0 29.0
300.0 31.4 37.4 59.2 55.7 27.8 24.8
350.0 34.1 40.6 58.2 54.7 24.1 21.1
400.0 36.7 43.7 57.3 53.8 20.6 17.6
450.0 39.2 46.6 56.6 53.1 17.4 14.4
500.0 41.5 49.4 55.9 52.4 14.4 11.4
550.0 43.8 52.1 55.3 51.8 11.5 8.5
600.0 46.0 54.7 54.7 51.2 8.7 5.7

Measurement Limits in dB
Freq Power Sum NEXT ELFEXT Power Sum ELFEXT Return Loss

( MHz ) Permanent Channel Permanent Channel Permanent Channel Permanent Channel

1.0 62.0 62.0 65.0 65.0 62.0 62.0 21.0 19.0
4.0 62.0 62.0 65.0 65.0 62.0 62.0 21.0 19.0
10.0 62.0 62.0 62.7 60.8 59.7 57.8 21.0 19.0
16.0 62.0 62.0 59.3 57.5 56.3 54.5 20.0 18.0
100.0 62.0 59.9 46.0 44.4 43.0 41.4 14.0 12.0
250.0 57.4 53.9 39.2 37.8 36.2 34.8 10.0 8.0
300.0 56.2 52.7 37.8 36.4 34.8 33.4 10.0 8.0
350.0 55.2 51.7 36.7 35.3 33.7 32.3 10.0 8.0
400.0 54.3 50.8 35.7 34.3 32.7 31.3 10.0 8.0
450.0 53.6 50.1 34.8 33.4 31.8 30.4 10.0 8.0
500.0 52.9 49.4 34.0 32.6 31.0 29.6 10.0 8.0
550.0 52.3 48.8 33.3 31.9 30.3 28.9 10.0 8.0
600.0 51.7 48.2 32.6 31.3 29.6 28.3 10.0 8.0
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Tester Performance Levels

There are two types of performance levels you need to consider when preparing to
perform cable testing:

• The performance category of the cable system.

• The accuracy of the field tester.

Twisted Pair Cable Categories

Categories Description

CAT 1 and 2 UTP, not recommended for LAN use.

CAT 3 Four pairs with three twists per foot.  Rated for signals up to
16 MHz.

CAT 4 Four pairs per foot.  Rated for signals up to 20 MHz.

CAT 5 Four pairs with eight twists per foot.  Rated for signals up to
100 MHz.

CAT 5E Same characteristics as CAT 5.  Higher quality cable (low
crosstalk).  Rated for signals up to 200 MHz.

CAT 6 Four pairs with each pair wrapped in foil insulation. Rated
for signals greater than 250 MHz.
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Field Tester Accuracy

It is difficult to determine which type of tester may be required for certification.
Generally, Level I testers are used by LAN managers for casual troubleshooting.
Level II and Level III testers are used by cable installation contractors.

What does “accuracy” mean?

Accuracy is the difference between the measured value reported by the LANTEK
tester and the actual value. Accuracy is a function of the characteristics of the field
tester and link transmission characteristics.

Requirements for Level I, II, and III Accuracy

Accuracy requirements are specified in the TIA/EIA 568-B and ISO Class-E
specifications. A CAT6 tester is required to meet Level III requirements from
1 to 250 MHz.
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Accuracy Levels

The following tables list the Level I, II, and III accuracy levels defined by the
TIA/EIA 568-B and ISO Class-E specifications.

Level I Level II

1 - 100 MHz 1 - 100 MHz

Random Noise Floor 50 -15 log (f/200)dB 65 -15 log (f/200)dB

Residual NEXT 40 -15 log (f/200)dB 55 -15 log (f/200)dB

Output Signal Balance 27 -15 log (f/200)dB 37 -15 log (f/200)dB

Common Mode Rejection 27 -15 log (f/200)dB 37 -15 log (f/200)dB

Dynamic Accuracy ± 1.0 dB ± 0.75 dB

Length Accuracy ± 1 meter ± 4% ± 1 meter ± 4%

Return Loss 15 dB 15 dB

Directivity  --  --

Delay  --  --

Level III - Draft 3 Level III - New Proposal

1 - 250 MHz 1 - 250 MHz

Random Noise Floor 70 -15 log (f/200)dB 75 -15 log (f/100)dB

Residual NEXT 60 -15 log (f/200)dB 65 -20 log (f/100)dB

Output Signal Balance 35 -15 log (f/200)dB 40 -20 log (f/100)dB

Common Mode Rejection 35 -15 log (f/200)dB 40 -20 log (f/100)dB

Dynamic Accuracy ± 0.5 dB ± 0.75 dB (±1.0 dB ELFEXT)

Length Accuracy ± 1 meter ± 4% ± 1 meter ± 4%

Return Loss 15 -15 log (f/200)dB 25 -15 log (f/100)dB

Directivity 25 -15 log (f/200)dB 27 -7 log (f/100)dB

Delay 5 ns + 4% 5 ns + 4% EINBETTEN
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Permanent and Channel Link Test Limits

The following tables define the basic and channel link test limits defined by the
TIA/EIA 568-B, ISO Class-C, D, and E specifications.

ANSI/TIA/EIA
TEST Limits

Link Channel Link Channel Link Channel Link Channel

Length (m) 94 100 94 100 94 100 94 100
Loop Resistance (DC Ohm) 20 20 20 20 20 20 40 40
Capacitance/m 66pF 66pF 66pF 66pF 66pF 66pF 66pF 66pF
Delay (10MHz) 510 548 510 548 510 548 506 557
Skew/ns 43 50 43 50 43 50 43 50
Impedance (Ohm) 85-115 85-115 85-115 85-115 85-115 85-115 85-115 85-115

Proposed
TSB67 Category 3 TSB67/95 Category 5 TSB67 Category 5e TSB67 Category 6

Proposed

ISO/AS/NZS
TEST Limits

Link Channel Link Channel Link Channel Link Channel

Length (m) 90 100 90 100 90 100 90 100
Loop Resistance (DC Ohm) 40 40 40 40 40 40 40 40
Capacitance/m 56pF 56pF 56pF 56pF 56pF 56pF 66pF 66pF
Delay (10MHz) 497 555 497 555 497 555 497 555
Skew/ns 43 50 43 50 43 50 43 50
Impedance (Ohm) 85-115 85-115 85-115 85-115 85-115 85-115 85-115 85-115

ISO Class-C AS/NZS 3080 ISO Class-D ISO Class-E
ISO Class-D 11801 Proposed Proposed

EINBETTENEINBETTENEINBETTENEINBETTEN
EINBETTENEINBETTEN
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• LANTEK Cables, Adapters and Accessories

• Environmental and Physical Specifications

LANTEK Cables, Adapters, and Accessories

Part Number Description

1219-00-1604 Battery Pack Cartridge for Handsets; Extra/Spare/Replacement

3070-70-0015 Headset, Set of 2; Includes earphone, microphone, vinyl case
and user’s guide

0012-00-0642 *c Dual Bay, Quick Charge Battery Recharger for LANTEK;
switchable 120V, 240V Power

1019-00-1510 North American Wall Cube AC/DC Power Supply

1019-00-1511 European Wall Cube AC/DC Power Supply

1019-00-1512 United Kingdom Wall Cube AC/DC Power Supply

0012-00-0627 Category 6 Channel Adapter

0012-00-0626 Category 7 Channel Adapter

6011-50-0029 Category 6 Patchcords (RJ45 to RJ45) Set of 2

6011-50-0028 Category 7 Patchcords (RJ45 to Tera) Set of 2

6011-50-0027 Category 7 Patchcords (Tera to Tera) Set of 2

6011-59-0030 Serial Cable

6011-59-0031 USB Cable

2112-27-0603 PCMCIA Flash Card Adapter for LANTEK 6/7
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Model Number Description

2112-27-0602 32 MB Compact Flash Card

2112-27-0604 USB Flash Card Reader for PC

3010-12-0092 Deluxe Hard-Shelled Carrying Case; holds tester set,
rechargers, link adapters and accessories

3010-12-0096 Soft Carrying Case; holds tester set, rechargers, link adapters
and accessories

0012-00-0624 Coax Adapters; Set of 2

0012-00-0338 Singlemode 1310 nm fiber optic adapter module

0012-00-0339 Singlemode 1550 nm fiber optic adapter module

0012-00-0336 Multimode 850 nm fiber optic adapter module

0012-00-0337 Multimode 1300 nm fiber optic adapter module

0012-00-0341 Singlemode TRACETEK Adapter

6011-00-1017 Singlemode TRACETEK Long Launch Cable *d

6011-20-5004 Singlemode 50-50 Splitter

0012-00-0340 Multimode TRACETEK Adapter

6011-00-1016 Multimode TRACETEK Long Launch Cable *d

6011-20-5003 Multimode 50-50 Splitter

6011-50-0035 Battery Charger Cord for USA/Canada

6011-50-0037 Battery Charger Cord for United Kingdom

6011-50-0036 Battery Charger Cord for Europe

*c – Specify Country Code for AC Power Cord.

*d – Long Launch Cables are sometimes known as Dead Zone Eliminators.
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Environmental and Physical Specifications

The following environmental specifications apply to all LANTEK Cable Testers.

LANTEK 6 Specifications

Range Resolution Accuracy

Length (50 0r 100 Ω� Cable) 0-2000 ft 1 ft +(3% + 3 ft)

Delay 0-8000 ns 1 ns +(3% + 1 ns)

Average Impedance 35-180 Ω 0.1 Ω +(3% + 1 Ω)

Capacitance (Bulk) 0-100 nF 1 pF or 3 dig +(2% + 20 pF)

Capacitance 0-100pF/ft 0.1 pF +(2% + 1 pF)

DC Loop Resistance 0-200 Ω 0.1 Ω +(1% + 2 Ω)

Attenuation 1-350 MHz 0.1 dB Level III*

NEXT 1-350 MHz 0.1 dB Level III*

Return Loss 1-350 MHz 0.1 dB Level III*

ELFEXT 1-350 MHz 0.1 dB Level III*

Noise Floor >-90 dB

Dynamic Range < 90 dB

* Level III only specified to 250 MHz

Storage Capacity (Internal Memory)

Cat 5e, 6 (No Graphics) 6,000 Test Results

Cat 5e with Graphics 100 Test Results

Cat 6 with Graphics 60 Test Results

Storage Capacity (External 32MB Flash)

Cat 5e, 6 (No Graphics) 24,000 Test Results

Cat 5e with Graphics 400 Test Results

Cat 6 with Graphics 240 Test Results
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LANTEK 7 Specifications

Range Resolution Accuracy

Length (50 0r 100 Ω� Cable) 0-2000 ft 1 ft +(3% + 3 ft)

Delay 0-8000 ns 1 ns +(3% + 1 ns)

Average Impedance 35-180 Ω 0.1 Ω +(3% + 1 Ω)

Capacitance (Bulk) 0-100 nF 1 pF or 3 dig +(2% + 20 pF)

Capacitance 0-100pF/ft 0.1 pF +(2% + 1 pF)

DC Loop Resistance 0-200 Ω 0.1 Ω +(1% + 2 Ω)

Attenuation 1-750 MHz 0.1 dB Level III*

NEXT 1-750 MHz 0.1 dB Level III*

Return Loss 1-750 MHz 0.1 dB Level III*

ELFEXT 1-750 MHz 0.1 dB Level III*

Noise Floor >-90 dB

Dynamic Range < 90 dB

* Level III only specified to 250 MHz

Storage Capacity (Internal Memory)

Cat 5e, 6 (No Graphics) 6,000 Test Results

Cat 5e with Graphics 100 Test Results

Cat 6 with Graphics 60 Test Results

Cat 7 with Graphics 25 Test Results

Storage Capacity (External 32MB Flash)

Cat 5e, 6 (No Graphics) 24,000 Test Results

Cat 5e with Graphics 400 Test Results

Cat 6 with Graphics 240 Test Results

Cat 7 with Graphics 100 Test Results
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Temperature Range

Operating Temperature Range: 0 to + 50 degrees C

Storage Temperature Range: -20 to +70 degrees C

Humidity

5-90%, noncondensing

Shock / Bench Handling

LANTEK testers are capable of surviving the normal bench handling procedures
found in typical maintenance and repair facilities.

Connector Stress

Strain

All connectors and adapters will withstand a strain of > 25 lb. in any direction or
orientation when attached to a Display Handset or Remote Handset.

Jerk

All connectors and adapters will withstand a jerk force of up to 1 lb. dropped from
a 3 foot cord in any orientation when attached to a Display Handset or Remote
Handset.
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Dimensions and Weight

Display Handset

Dimensions: 10.1"x5.0"x2.3"

Weight: 2 lbs. 3 oz.

Remote Handset

Dimensions: 10.1"x5.0"x2.3"

Weight: 2 lbs.

Battery and Power Management

Display Handset

Battery Pack: 8.4 Vdc, 2.45 AH, NiMH

External Source: 12 Vdc, 800mA continuous

Remote Handset

Battery Pack: 8.4 Vdc, 2.45 AH, NiMH

External Source: 12 Vdc, 800mA continuous

Test Connector Input Protection

Input Impedance: 2 MΩ

Voltage Protection: 20-200 VAC/DC
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saving current results, 4-16
stored, 4-17
viewing current, 4-12

Autotest Results
pass/fail reporting, 4-10
symbols, 4-10

Autotest setup, 4-5
Autotest suites, 4-2

B

Battery and Power Management, 2-18
Battery charging, 2-20
baud rates, 6-7

C

Cable ID, 3-29
double, 3-30
single, 3-29

Cable IDs and Test Numbering, 3-27
Cable Type Selection, 3-31
Cable types and applicable analyze tests,

5-2
Calibration, 3-6
Calibration Procedure, 1-4
Capacitance Errors, 7-27
Capacitance Test, 7-26
Capacitance Troubleshooting, 7-27
Channel Link Loss, 3-5
Channel Link Test Setup, 1-6, 7-5
Custom Cable

Parameter Options, 3-38
Custom Cable Parameters, 3-38
Custom Cable Settings, 3-34
custom cable type

creating, 3-34

D

Database directory, 6-25
DB-9 Serial Port, 2-13
DC Input Jack, 2-13
DC Resistance Errors, 7-11



Index-2

DC Resistance Test, 7-10
DC Resistance Troubleshooting, 7-11
Delay and Skew Errors, 7-25
Delay and Skew Test, 7-24
Delay and Skew Troubleshooting, 7-25
Deleting Tests, 4-17
Digital Talkset, 3-41
Display Handset, 2-6

Ready screen
Function keys, 2-10

Display Handset connectors, 2-13
Display Handset Controls, 2-6
Display Handset front panel, 2-6
Display Handset Interface Ports, 2-13

F

Field calibration
failure, 3-10

Find, 6-40

H

Hard and Soft Keys, 2-10
Headroom Errors, 7-31
Headroom Test, 7-30
Help menu, 6-18

I

Impedance Errors
Impedance Test, 7-22
Impedance Troubleshooting, 7-23

J

Job folder, 6-27
Jobs, 4-14, 6-27

creating, 4-14

L

LANTEK Basic Package, 1-1
LANTEK Cable Tester, 2-1
LANTEK Features, 2-2
LANTEK Performance Specifications, 2-

3
LANTEK Premier Package, 1-1
LANTEK Reporter

customer details, 6-30
Database file menu, 6-25
display test grid, 6-33
edit menu, 6-11
find, 6-32
Job

editing, 6-29
view test details, 6-34

LANTEK Reporter
backup and restore databases, 6-41
Database opening, 6-26
editing test, 6-38
file menu, 6-9
finding data, 6-40
Graph Button, 6-35
help menu, 6-16
help system overview, 6-18
installation, 6-3
Job

adding, 6-28
job tree, 6-27
menu bar, 6-8
moving test, 6-37
options menu, 6-15
sorting test, 6-39
startup, 6-4
status bar, 6-16
Test

uploading, 6-22
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toolbar, 6-17
user interface, 6-8
Using Graph Data, 6-24
view menu, 6-13
working with databases, 6-25

LANTEK Reporter
connecting to PC, 6-4

LANTEK Reporter Graph Display, 6-35
LCD Display, 2-8
Loss Component Effect, 3-5
Low-Crosstalk Connector, 2-13

N

NEXT , ELFEXT Troubleshooting, 7-17
NEXT, ELFEXT Errors, 7-17
NEXT, ELFEXT, Power Sum Test, 7-12

O

Operational Sequence, 2-18

P

Performing a Channel Link Test, 3-7
Performing a Permanent Link Test, 3-6
Performing a TDR, 3-44
Performing Autotest on a Twisted Pair

Cable, 1-7
Permanent Link Loss, 3-5
Permanent Link Test Setup, 1-6, 7-4
ports, 6-7
Power-up, 1-3
Preferences screen

setting tester configuration
parameters, 3-11

Q

Quick Start Procedures, 1-3

R

Remote Handset, 2-15
Remote Handset Controls, 2-15
Remote Handset Interface Ports, 2-17
Removable Mass Storage, 2-14
Report

Single Line, 6-45
Report

Brief, 6-46
Detailed, 6-47
footer, 6-42
header, 6-42
print command:, 6-44
printing, 6-42
setup:, 6-43

Return Loss Errors, 7-21
Return Loss Test, 7-20
Return Loss Troubleshooting, 7-21
Right mouse button, 6-17

S

Saving Tests, 4-14, 4-16
Self-Test, 1-3
Serial Port Interface Cable, 6-4
Set Operator, 6-31
Shielded cabling systems, 1-5
Single and Double Cable IDs, 3-27
Sort, 6-39
Status Bar, 6-16

T

Talkset Jack, 2-13
TDR, 3-42
TDR Applications, 3-43
TDR Graph, 3-46
TDR Results
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Evaluating, 3-49
Interpreting, 3-48
Storing, 3-50
Viewing, 3-48

Telco lines, 1-5
Test button, 6-8
Test Counter, 3-28
Test records, 6-27
Tester configuration

adjusting display contrast, 3-15
clearing memory, 3-25
configuring the PC or printer

Interface, 3-18
configuring the talkset, 3-19
entering user information, 3-12
pack memory, 3-24
restoring factory defaults, 3-23
select save media, 3-26
selecting a display language, 3-22
setting, 3-11
setting Autotest preferences, 3-13
setting date and time, 3-21
setting length measurement units, 3-17
setting length measurement units, 3-17

setting timeout options, 3-16
Tester Field Calibration, 3-8
Tester Field calibration setup, 3-8
Tester to PC Connection, 6-6
Testing Twisted Pair Cables, 7-2
Tests

moving, 6-37
Tone Generator, 3-39
Tone Generator setup, 3-39
Twisted Pair Cable Connections, 1-5

U

USB Interface Cable, 6-5

W

Warning screens, 3-7
Wire Length Errors, 7-9
Wire Length Test, 7-8
Wire Length Troubleshooting, 7-9
Wire Map Errors, 7-6
Wire Map Test, 7-6
Wire Map Troubleshooting, 7-7


